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SOFTWARE LICENSING AGREEMENT

This Software License Agreement (the “Agreement”) is a legal Agreement 
between the end user, either, an individual or business entity (“Licensee”) 
and Christie Digital Systems USA, Inc. (“Christie” or “Licensor”) for the 
software known commercially as MASTERSuite  5.0 (“Software”).  If 
Licensee does not accept the terms of this Agreement, Licensee shall return 
the Christie product and the software to the vendor.

LICENSE AND RESTRICTIONS

Ownership of Software: Christie and its third party suppliers retain title and 
ownership of all rights, including copyright and all other intellectual 
property rights, in and to the Software and accompanying written materials 
(the “"Documentation”"), and all copies thereof, regardless of form or 
media.  This License is not a sale of any rights in or to the Software or the 
Documentation or any copy thereof. Licensee acquires no right whatsoever 
to the Software or the Documentation except the right to use the Software 
and the Documentation in accordance with the terms of this License.  

Third Party Licenses: Licensee acknowledges that the Software may 
utilize software and other materials provided by third parties.  Such third 
parties may enforce the provisions of this License to the extent such third 
party software and other materials are used by Licensee.  Any limitation of 
liabilities in this License also apply to such third party suppliers and the third 
party software and other materials provided by them.  Such limitation of 
liabilities, apply to the Software as a whole and are not cumulative.

Grant of License: The Licensor grants to Licensee, a non exclusive and 
non-transferable right to use for personal or internal business purposes, the 
executable version of the Software and the Documentation, as long as 
Licensee complies with the terms and conditions of this License. Licensor 
reserves all rights not expressly granted to Licensee.

Copy Restrictions: Licensee may keep one copy of the Software solely for 
backup or archival purposes.  Unauthorized copying or distribution of the 
Software, including Software which has been modified, merged, or included 
with other software or of the Documentation is expressly prohibited unless 
agreed to in writing by Christie. Licensee must reproduce and include the 
copyright notice on any backup copy of the Software and Documentation. 
Licensee may not remove any proprietary rights or copyright notice or 
identification which indicates the ownership by Christie of the Software or 
the Documentation.  

Use Restrictions: Licensee shall not (a) modify, adapt, decompile, 
disassemble reverse engineer, or otherwise attempt to derive the source code 
for the Software, or create derivative works based on the Software or the 
Documentation; (b) assign this License or redistribute, encumber, sell, 
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transfer, lease, or grant a sublicense of the Software or the licenses granted 
herein or otherwise transfer rights to the Software to any person or entity 
except as and when authorized by the Licensor in writing; (c) directly or 
indirectly, export or transmit the Software, either alone or bundled with other 
software, to any country to which such export or transmission is restricted by 
any applicable laws without the appropriate prior written consent of the 
applicable government entity or department.  Licensee will make reasonable 
efforts to prevent any unauthorized use of the Software or Documentation by 
third parties and will advise Licensee's employees of the restrictions upon 
use restrictions herein.

MAINTENANCE AND SUPPORT

Term of Maintenance and Support: The Licensor shall provide 
maintenance and support services related to the Software (“Support 
Services” for a period of 90 days from the date of receipt of the Software). 
Support Services are governed by the Licensor'’s policies and programs 
described in materials provided by the Licensor. Any supplemental software 
code provided to the Licensee as part of the Support Services shall be 
considered part of the Software and subject to the terms and conditions of 
this Software License Agreement.

WARRANTY AND LIMITATION OF LIABILITY

Product Warranties: The Licensor warrants that the Software will perform 
substantially in accordance with the accompanying written materials for a 
period of 90 days from the date of receipt of the Software. This warranty is 
void if the Licensee or any third party changes or modifies the Software. The 
liability of this Licensor under this section is limited to the correction of any 
error or malfunction and shall not include liability for loss of data, loss of 
computer time, any direct damages or any indirect or consequential 
damages. This warranty only extends to those failures communicated to the 
Licensor in writing within 90 days of the receipt of the Christie Digital 
product. The Licensor does not warrant that the Software is free from any 
minor defects or that it will operate uninterrupted. The Licensor does not 
make any other warranties, either express or implied, including, but not 
limited to, implied warranties of merchantability, fitness for a particular 
purpose, title and non-infringement, with regard to the Software. Some 
jurisdictions do not allow limitations or duration of an implied warranty, so 
the above limitation may not apply to you.

Licensee’s Remedy: The Licensor’s entire liability and the Licensee'’s 
exclusive remedy shall be repair or replacement of the Software that does 
not meet the Warranty. Any replacement Software will be warranted for the 
remainder of the original warranty period or thirty (days), whichever is 
longer.
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Exclusions and Limitation of Liability: In no event shall the Licensor be 
liable for any loss of data or profits or special, incidental, indirect or 
consequential damages, (including, without limitation, damages for loss of 
business profits, business interruption, loss of business information, or any 
other pecuniary loss) arising out of or in connection with the use of or 
inability to use the Software, even if the Licensor has been advised of the 
possibility of such damages. In no event will the Licensor be liable for any 
damages caused by the Licensee’s failure to meet Licensee’s responsibilities, 
which responsibilities include without limitation, the provision of properly 
functioning and compatible hardware, operating systems, or applications 
software, or arising out of incomplete or inaccurate information provided to 
the Licensor. In any case, the Licensor’s entire liability under this 
Agreement shall be limited to CDN$1,000.

TERMINATION AND DEFAULT

Termination: The Licensor may terminate this Agreement if the Licensee 
breaches or is in default of any obligation. Should this Agreement be 
terminated for any reason, the Licensee agrees to immediately cease using 
the Software and to return to the Licensor all copies of the Software. The 
Licensee'’s obligation under this section shall survive the termination of the 
Agreement.

GENERAL

Notices: Unless otherwise set forth in this Agreement, all notices, demands 
or other communications to the Licensor hereunder shall be in writing 
(including telecopy) and shall be deemed to have been duly given if 
delivered during normal business hours by hand, Federal Express, United 
Parcel Service or other reputable overnight commercial delivery service, by 
telecopy, confirmation of receipt received, or by mail with return receipt 
requested, addressed as follows:

Christie Digital Systems USA, Inc.
c/oChristie Digital Systems Canada, Inc.
Legal Department
809 Wellington Street North
Kitchener, Ontario
N2G 4Y7

Severability: If any provision of this Agreement is held to be invalid, such 
invalidity shall not affect the other provisions of this Agreement.

Waiver: No waiver by the Licensor of any particular default or omission 
committed by the Licensee shall affect or impair the right of the Licensor in 
respect of any subsequent default or omission of the same or a different kind. 
No delay or failure by the Licensor to exercise any rights in connection with 
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any default or omission committed by the Licensee shall affect or impair the 
Licensor'’s rights in respect of that particular default or omission or any 
subsequent default or omission of the same or different kind. In any event, 
time shall continue to be of the essence without the necessity of specific 
reinstatement.

Governing Law: This Agreement shall be governed by and interpreted in 
accordance with the laws of the Province of Ontario and the federal laws of 
Canada applicable therein. The Parties hereby will attorn to the non-
exclusive jurisdiction of the Courts of the Province of Ontario.
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1 MASTERSuite  
Introduction

1.1 About MASTERSuite

MASTERSuite is a collection of integrated software modules that allows for 
flexibility when working with the display wall. MASTERSuite is comprised 
of MediaManager, WallManager, and a collection of applications for easy 
remote operation. 

1.2 In this Document

Chapter 1 Introduction: The current chapter.

Chapter 2Software Setup and Administration: MediaManager and 
WallManager can be configured to best suit your environment. 

Chapter 3Showing Media on the Display Wall: MediaManager allows you to 
specify and configure media to be shown on the display wall. 

Chapter 4Managing the Display Wall: WallManager allows you to control 
the display walls remotely, and it allows you to create and schedule scenarios 
that include multiple windows.

Chapter 5 Remote Operation Client PC: A variety of small applications are 
provided that extend remote operation functionality. 

Chapter 6Setting Wall Display Properties: Advanced display property 
settings.

Chapter 7Troubleshooting: Information about common issues.

1.3 Related Documents

Software setup and operation information is included in the on-line help. 

The TVC Controller manual includes information about the controller, the 
expansion chassis, the input modules, and system configurations.

The Installation Guide includes information required in the event that the 
controller software must be re-installed.
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2 Software Setup and 
Administration
MASTERSuite is a suite of programs used to configure (MediaManager) 
and display (WallManager) media content on a TVC display wall. The 
controller comes with MASTERSuite installed. If for any reason you need to 
re-install the MASTERSuite software on the controller, see the 
MASTERSuite Installation Manual.

This section includes: 

2.1 MediaManager Setup

2.2 WallManager Setup

2.1 MediaManager Setup

Set up MediaManager on the controller or on a laptop using WallManager. 

Once you have set up channels and profiles in MediaManager, you can 
include MediaManager content in WallManager scenarios and work with 
MediaManager remotely. To work with MediaManager remotely, install 
WallManager and access MediaManager in WallManager’s Interactive 
mode. See 5.1WallManager on a Remote PC and Controllers Views on 
page 4-6.

The following instructions assume that you are working directly on the 
controller. 

2.1.1 Start MediaManager

2.1.2 Configure Language

2.1.3 Manage Channels

2.1.4 Hotkey Configuration

NOTE: MASTERSuite security is controlled in WallManager. See 
2.2.4 Security.
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Section 2: Software Setup and Administration
2.1.1 Start MediaManager

The first time you start MediaManager, the License window appears. Read 
and accept the License to continue. 

1. Log into the controller with an administration level user account.

2. At the display wall, click Start>All 
Programs>Christie>MASTERSuite>Christie MediaManager. 
The default window appears. 

Figure 2-1 Default MediaManager Window

The default window can be changed for future start-up by changing the 
default profile. 
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Section 2: Software Setup and Administration
2.1.2 Configure Language

Select the Language

1. In the MediaManager window, click Administration>Languages. 
The submenu lists the supported languages. 

Figure 2-2 Language Selection 

2. Select a language.

The change is immediate. All MediaManager dialogs and windows are 
converted to the selected language.

NOTE: Text fields such as Name and Descriptions are not affected by 
this change. These fields can be entered in any language regardless of 
the language selected for MediaManager. 

Wrong Language Selected

Use the following procedure if you have configured MediaManager to use a 
language that you cannot read.

1. In the MediaManager window, click the fifth (5) menu in the menu 
bar.

2. On the fifth menu, click the third (3) item to expand the list of supported 
languages.

3. Select the desired language. English is the first option. See Figure 2-2.

2.1.3 Manage Channels

The first time you start the MediaManager software it creates a default set of 
input source channels. The channels are based on the input modules detected 
in the system. You can rename channels to make the channel contents clearer 
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Section 2: Software Setup and Administration
to users. You can also change properties, such as brightness. For detailed 
descriptions of the settings you can change, see Channel Properties Dialog 
on page 2-6.

This section includes the following:

• Rename Channels

• Create New Channel

• Edit Channel Properties

• Delete a Channel

• Restore Default Channels

• Select Device Dialog

• Channel Properties Dialog

Rename Channels

MediaManager channels are named for their respective input modules. 
Renaming channels to reflect content makes it easier to identify the correct 
input source when you set up media windows on the display wall.

IMPORTANT! Profiles refer to channel names. If you change a channel 
name after it has been included in a profile, change the profile to refer to the 
new name. 

1. In the MediaManager window, click Administration>Channel 
Configuration. The Channel Configuration dialog appears.

Figure 2-3 Channel Configuration

2. Select the channel you want to rename.

3. Click Rename. The Name cell for the selected channel is activated.

4. Modify the name and press Enter.
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Section 2: Software Setup and Administration
Create New Channel

1. In the MediaManager window, click Administration>Channel 
Configuration. The Channel Configuration dialog appears.

2. Click Add. The Select Device dialog appears.

Figure 2-4 Select Device Dialog

3. Select the appropriate device from the select device type list. For 
example, for a remote desktop channel pick RemoteDesktop.

4. Click OK. The new channel is added to the list.

5. With the new channel selected click Edit. The Channel Properties 
dialog for the specified device type appears. See Channel Properties 
Dialog on page 2-6.

6. Change the channel settings until you are satisfied with the effect and 
click Save.

NOTE: Alternatively, select an existing channel and click Copy.The new 
channel has the same properties.

Edit Channel Properties

1. In the Channel Configuration dialog, select the channel you want to 
change, and click Edit.

2. Adjust the channel properties. See Channel Properties Dialog on 
page 2-6.

3. Click Save.

Delete a Channel

1. In the Channel Configuration dialog, select the channel you want to 
delete, and click Delete.

2. Click Yes to confirm.

Restore Default Channels

Restores all channels to their default settings.

Notes: 1) You cannot restore a single default channel. 2) The action of 
restoring default channels is final – you cannot regain the channels once 
they are deleted. 
MASTERSuite 5.0 User Manual 2-5
020-100448-01 Rev. 1 (03-2010)



Section 2: Software Setup and Administration
1. In the MediaManager window click Administration>Channel 
Configuration. The Channel Configuration dialog appears. 

2. In the Channel Configuration dialog, click Restore Defaults. 

3. Click Yes to confirm the deletion of existing information and the 
restoration of the channel defaults.

Select Device Dialog

Select Device Type – The device type identifies the channel’s input 
module from which the MediaManager window receives a signal. Devices 
are:

V16A – Select this device when you want to display the video sources 
connected to the V16A module. This module supports multiple videos 
per display device.

V4 – Select this device when you want to display video sources 
connected to the V4 module. This device supports only one active video 
per display device.

V9  – Select this device type when you want to display the video 
sources connected to the V9 module. This device supports multiple 
videos per display device.

D2R2 – Select this device type when you want to display an analog or 
digital RGB source connected to any D2R2 module.

RemoteDesktop – Select this device when you want to display the 
desktop of some other computer on the network other than the 
controller. 

NOTE: RDClient must be installed on the other PC for the remote 
desktop feature to work. 

Channel Properties Dialog

The Channel Properties dialog allows you to review and change the 
properties associated with a channel. 

The options available from the Channel Properties dialog depend on whether 
the signal source is from a video, an RGB device or a RemoteDesktop. 
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Section 2: Software Setup and Administration
Figure 2-5 Channel Properties Dialog

Name (All) – The default name for a channel is based on the channel’s 
device type, for example RGB 03. You can rename channels so that users can 
identify the contents from the name, but if you have already created profiles 
that refer to the old name, those profiles need to be updated. Profile 
references to names that no longer exist result in a “Channel: None Selected” 
message in the MediaManager window.

Overlay Text (All) – The default overlay text reflects the default channel 
name. You can change it to identify the channel’s source. For example, 
“Back door”.

Input # (RGB, Video)  – The Input # specifies which input port on the 
device to use. When you try to open a window to an input that is already 
being used, the window displays a “device in use” image in the 
MediaManager window. 

The range of Input #’s available depends on the number of modules installed 
on the specified device type.

NOTE: D2R2 modules cannot have more than 4 windows displaying the 
same input channel.

Remote Control – Indicates whether the user at the controller can take 
control of the displayed remote desktop using the controller’s keyboard and 
mouse. When Remote Control is checked, MediaManager right-click menus 
are not available in the MediaManager window displaying the remote 
desktop. Mouse and keyboard actions in the remote desktop window are sent 
to the remote desktop.
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Backup channel – Identifies the channel Media Manager will switch to if 
the current channel is selected but not available. 

Video Type (Video) – Specify the type of video signal that should be 
displayed by selecting one of the following video types: 

• Composite A Video – 1 BNC connector (default)

• Composite B Video – 1 BNC connector, second input for V9 module

• S-Video – 2 BNC connectors

Video Standard (Video) – Select the proper video standard from the 
Video Standard drop-down menu. This specifies which video standard the 
signal has been encoded in. 

Host Name/IP (RemoteDesktop) – Host Name/IP specifies the IP 
address or full name of the remote computer. 

Port (RemoteDesktop) – Port specifies the port number of the remote 
computer. 

Maximum Sample Rate (RGB, RemoteDesktop)  – The Maximum 
Sample Rate specifies how quickly the window updates (refreshes) in frames 
per second. The maximum attainable refresh rate is dependent on how much 
bandwidth is available on the PCI bus. Setting a high sample rate reduces 
bandwidth availability for other applications and other RGB windows. It can 
also cause irregular updates when one or more windows are open. 

If you notice irregular updates or ghosting, decrease the Maximum Sample 
Rate value until the updates occur more smoothly.

Password (RemoteDesktop) – A password is only required to connect to 
a remote desktop if authentication has been enabled (with a password) in the 
RDClient application on the remote desktop. Specify the password that was 
set up on the remote desktop's RDClient. 

If a password is not provided when the channel is set up and authentication is 
enabled, you will be prompted for the password when the channel is selected 
for display.

Image Adjustments (RGB, Video) – The bottom half of the Channel 
Properties window is dedicated to image adjustment settings. The options 
that appear in this section change depending on whether you are working 
with Video or RGB signals. Most options have an adjustable slide bar. 
Moving it toward the right increases the value of the setting and moving to 
the left decreases it. The exact value appears to the right of the slide bar. 
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Brightness (RGB, Video) – Adjust the slide bar until the desired image 
brightness is achieved. A high brightness setting could turn the black areas 
of an image to dark gray. This could create an overall “washed-out” 
appearance of the image. If the brightness setting is set too low, the dark 
areas of an image appear black (“crushed”).

Contrast (RGB, Video) – Adjust the slide bar until the desired image 
contrast is achieved. A high contrast setting can cause the light areas of the 
image to appear white and distorted. If the contrast setting is too low, the 
image could appear dim. 

Brightness Color Balancing (RGB) – Adjust the slide bar until the 
desired color balance is achieved for brightness. This adjustment is made 
separately for each color channel.

Contrast Color Balancing (RGB) – Adjust the slide bar until the desired 
color balance is achieved for contrast. This adjustment is made separately for 
each color channel.

Saturation (Video)  – Adjust the slide bar until the desired color 
saturation is achieved.

Hue (Video)  – Adjust the slide bar until the image displays the desired 
hue. Applies only to NTSC video output.

Enable AGC (Video) – Enable AGC to activate the “automatic gain 
control” circuit to make sure properly bright images. AGC affects decoded 
video image only. Disable this option if a decoded video image exhibits 
strange color artifacts such as stripes in highly saturated colors. This may 
indicate an incompatibility between the sources and the AGC.

Luma Gain (Video) – Adjust the slide bar to change the brightness of 
video sources that display incorrectly saturated colors. 

Use Pixel Tracking (RGB) – Check to enable pixel tracking. Adjust the 
slide bar to increase or decrease the frequency of the pixel sampling clock to 
correct the consistency of the image. 

Pixel Phase (RGB) – Adjust the slide bar so that any evident shimmer in 
the displayed image disappears and the image remains stable. 

Horizontal Offset (RGB) – Adjust the slide bar to shift the image from 
left to right.

Vertical Offset (RGB) – Adjust the slide bar to shift the image up or down.

Clamping Offset (RGB) – Adjust the slide bar when the image displays 
strong horizontal streaks or appears dim. In these cases, the clamp position 
requires adjustment to match the frequency of the incoming signal. 
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2.1.4 Hotkey Configuration

Many common tasks in MediaManager have been assigned hotkeys. For 
example, you can create a new profile by pressing CTRL + N. You can 
customize the hotkey assignments. 

Review Current Hotkey Configuration

1. To review the current hotkey configuration, click 
Administration>Keyboard Shortcuts. The Keyboard Shortcuts 
dialog appears.

Figure 2-6 Keyboard Shortcuts Dialog

2. Scroll down to see the complete list.

Customize a Hotkey Assignment

1. On the Keyboard Shortcuts dialog highlight a task in the window and 
click Edit. The Assign Hotkey dialog box appears.

Figure 2-7 Assign Hotkey Dialog

2. Type a hotkey combination in the Enter New Keyboard Shortcut 
field and click OK.

Notes: 1) You cannot assign the same hotkey to more than one task. 2) The 
ALT key is not available for MediaManager shortcuts. 3) Some hotkeys are 
reserved for Microsoft Windows tasks and cannot be used on another task.

Restore Default Keyboard Shortcuts

1. On the Keyboard Shortcuts dialog click Restore Defaults. 

2. Confirm the restoration of all the default shortcuts.
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2.2 WallManager Setup

WallManager is a client application used to set up TVC display walls. 
WallManager is pre-installed on the TVC controller with security disabled. 
Please see 2.2.4 Security.

Use WallManager to:

• Enable MASTERSuite security for remote access

• Set up user levels and users

• Set up applications for use on the display wall

• Set up display wall partitioning and access

• Set up scenarios (display wall layouts) and schedules

This setup section assumes that you are working directly on the TVC 
controller. It includes the following:

• 2.2.1 Initialize WallManager on the Controller

• 2.2.2 Setting Up Additional Controllers

• 2.2.3 WallManager Status

• 2.2.4 Security

• 2.2.5 Manage Users

• 2.2.6 Disable WallManager Security

• 2.2.7 Manage Applications in WallManager

• 2.2.8 Manage Server Status Notification

• 2.2.9 Manage Device Tasks

• 2.2.10 QuickLaunch

Interactive Mode allows you to work with the controller desktop, 
including media windows and applications from a remote PC. If you have 
multiple controllers to set up, you can work at one controller and connect to 
additional controllers. The setup activities all require an active connection to 
the controller being set up.
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2.2.1 Initialize WallManager on the Controller

1. Click Start>All 
Programs>Christie>MASTERSuite>WallManager.

Figure 2-8 Add a TVC Controller

2. To add a controller to the Controller tab, click the Add Controller 
button. WallManager detects available network computers 
automatically. 

3. Select the controller from the list and click OK. The controller is added 
to the Controller gallery.

Figure 2-9 Controller Added to WallManager

NOTE: If the controller is not in the list, you can type the name or IP 
address in the Select Network Computer field. 

4. To connect to the controller and add the display wall to the workspace, 
click the controller icon.
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Figure 2-10 Connected Controller, Wire-Frame View

NOTE: If WallManager security is enabled, enter a valid user name and 
password. 

Figure 2-11 Security Enabled, Login

Language Selection

Each installation of WallManager on a remote PC can work with their 
preferred language. 

1. Click the WallManager button and choose WallManager Options.

Figure 2-12 WallManager Options
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The WallManager Options dialog opens at the Popular options panel.

Figure 2-13 WallManager Language Selection

2. Select the language you want to use with your installation of 
WallManager. 

3. Click OK to close the options dialog.

2.2.2 Setting Up Additional Controllers

You can connect to multiple controllers and complete all the setup from one 
machine. Setting up multiple controllers at once lets you export scenarios 
from one controller to another.

Add a Controller

1. To add a controller, click the Add Controller icon and select an 
additional controller from the list.

Figure 2-14 Add a controller
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For each additional controller a labelled icon is added to the Controller 
tab.

Figure 2-15 Second controller added, not connected

2. To connect to the controller, click the Controller tab and select the 
controller icon. The display wall for the selected controller is added to 
the workspace.

Figure 2-16 Two Connected Controllers
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2.2.3 WallManager Status

1. Click the Controller Status tab and select the controller to review.

Figure 2-17 Status for Selected Controller

2.2.4 Security

Security settings are controller specific. When working with multiple 
controllers, a user can have administrative previleges on one controller and 
not on another.

Windows Security

The Windows Server 2003 operating system provides log-in control for 
direct access to the controller and the display wall. Once logged in you can 
interact directly with the display wall, including starting MediaManager 
windows or other applications.

For information about Windows security:

1. Click the Windows Start button.

2. Click Help and Support.

3. Search for User and Passwords.

4. Review the Users and Passwords Overview.
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WallManager Security

WallManager security controls access to WallManager functions such as 
scenarios and scheduling. It also controls remote access and the ability to 
work with multiple controllers and display walls from one machine. 

The TVC controller ships with WallManager security disabled. If you do not 
want to enable security, you can skip directly to 2.2.7 Manage Applications 
in WallManager. 

IMPORTANT: You can continue to operate the controller without enabling 
WallManager security. If security is not enabled and the controller is 
connected to a network, the controller is open to anyone who has access to 
your network.

To enable WallManager security:

1. Click the WallManager button and choose Security Settings.

Figure 2-18 Security Settings Button

The Security Settings dialog appears.

Figure 2-19 Password Required to Enable Security

2. Select the controller to work with and check Enable Security.

3. Sign in with a valid Level 1 account (Administrator).
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The User and User Group administration functions display when 
security is enabled.

Figure 2-20 Security Enabled

4. Continue to 2.2.5 Manage Users to set up permissions and user 
accounts for people who need access. 

2.2.5 Manage Users 

WallManager permissions and users can only be added or edited when 
WallManager security is enabled. Permissions for WallManager functions 
are specified for the four user levels. Users permissions assigned by 
assigning the user to a group level.

• Edit User Group Permissions

• Security Settings

• Create a Wall Partition

• Add a WallManager User

• User Settings

• Change User Password

• Edit User Information

• Delete a User

Edit User Group Permissions

WallManager software supports 4 user group levels. The software is shipped 
with permissions to WallManager functions disabled for all groups except 
for Level 1. Level 1 users always have access to all WallManager 
functionality. Only a Level 1 user can turn security ON and OFF. The other 
user groups can be defined as required, for example, Power User, 
Administrator, Everyone. 

Permissions for applications are initially enabled for all groups.
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To edit User Group Permissions:

1. Click the WallManager button and choose Security Settings.

2. Select the controller you want to work with.

3. If required, log in with an account that has User Maintenance 
permissions on the selected controller.

4. To edit permissions, click the group level you want to work with, for 
example Level 2.

Figure 2-21 User Group Permissions

NOTE: Level 1 cannot be edited. Level 1 users always have access to 
everything.

5. Check only the functions and applications that you want the users in this 
group to have access to and click Apply. 

6. Repeat this process for all the groups you want to use.

NOTE: For information about permissions options, see Security 
Settings on page 2-20.

7. Click OK to save your changes and close the dialog box.
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Security Settings

Permissions – Use these options to specify what the user can do in 
WallManager. New users are automatically granted the permissions assigned 
to their security group.

WallView View – Check this option to allow users to see the contents 
of the display wall in WallView.

WallView Edit – Check this option to allow users to have some basic 
control over windows on the display wall. For example users can move 
or close windows on the display wall without either LiveView or 
Interactive Mode enabled.

Interactive Mode – Check this option to allows users to interact with 
the contents of application windows.

Wall Partitioning – Check this option to limit user access to a portion 
of the display wall. Uncheck this option to give users full access. See 
Create a Wall Partition on page 2-21.

WallView Port Modify – Check this option to allow users to change 
the port WallManager uses to communicate with the server. This setting 
should only be made available to system administrators.

Start Scenario – Check this option to allow users to start scenarios.

Stop Scenario – Check this option to allow users to stop scenarios.

Edit Scenario – Check this option to allow users to create and change 
scenarios.

Lockdown Mode – Check this option to allow users to initiate 
“lockdown mode”. Lockdown mode limits user activity on the display 
wall and shuts down the scheduler until you exit Lockdown mode. For 
more information, see 4.3.11 Lockdown Mode.

User Maintenance – Check this option to allow users to add/delete 
users or change permissions.

Projector Setup – Check this option to allow users to execute 
projector functions available through WallManager and PowerTool.

Manage Device Tasks – Check this option to allow users to set up 
additional device tasks that can be run in a scenario.

Registered Applications – Check this to allow users to edit the list 
of registered applications and application properties.

Edit Schedules – Check this option to allow users to edit scheduling 
information for scenarios.
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RemoteControl – Check this option to allow users to access the wall 
using the RemoteControl application.

Launch MediaManager – Check this option to allow users to start 
MediaManager on the wall.

Controller Status – Check this option to allow users to view the 
Controller Status tab for the current controller.

SNMP E-mail – Use this option to give users access to the SNMP e-
mail setup.

Applications – Use these options to specify which registered applications 
the user can run on the display wall.

Create a Wall Partition

Wall partitions are part of the user group definition. All of the display wall is 
available by default. When you create a wall partition, you limit user access 
to the area of the partition in the following ways:

• WallManager and WallViewer users who belong to the group see only 
the partition defined for the group.

• WallManager and WallViewer users can interact only with elements 
they can see in their partition, provided they have permission to access 
those elements.

• WallManager users can only create or edit scenarios for their partition, 
provided they have scenario editing permissions.

Partitions do not prevent users with direct access to the controller and 
display wall from seeing and interacting with elements on the entire display 
wall using the TVC controller mouse and keyboard.

To create a partition:

1. Click the WallManager button and choose Security Settings.

2. Select the controller you want to work with.

3. If required, log in with an account that has User Maintenance 
permissions on the selected controller.

4. To access the user maintenance controls, click the group you want to 
restrict. 

5. Check Wall Partitioning and click Edit.
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6. In the Edit Group Wall Access dialog, click and drag to draw the area 
users have access to.

Figure 2-22 Edit Group Wall Access Dialog

7. Click OK to confirm the change and close the dialog.

8. Click OK to close the Security Settings dialog and click OK to 
confirm the changes.

Add a WallManager User

When managing users with access to multiple controllers, take care to 
duplicate user and password information on each controller a user has access 
to. Password changes can be applied to multiple controllers if the user name 
and password combinations are identical. 

1. Click the WallManager button and choose Security Settings.

2. Select the controller you want to work with.

3. If required, log in with an account that has User Maintenance 
permissions on the selected controller.
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4. To access the user maintenance controls, click Users. 

Figure 2-23 Security Settings Dialog

5. To create a new user, click Create.

Figure 2-24 Create User Dialog

6. Complete the Create User form. For information about the user 
information, see User Settings on page 2-23.

7. Repeat steps 5 and 6 for each new user.

User Settings

User Name – Identifies the account being modified.

First Name – Identifies the first name of the person the account belongs to.

Last Name – Identifies the last name of the person the account belongs to.
MASTERSuite 5.0 User Manual 2-23
020-100448-01 Rev. 1 (03-2010)



Section 2: Software Setup and Administration
Group – Identifies the security level of the account.

Password/Verify Password – Use these options to set or reset the current 
user’s password.

Create Button – Click this button to save the changes.

Change User Password

1. Click the WallManager button and choose Security Settings.

2. Select the controller you want to work with.

3. If required, log in with an account that has User Maintenance 
permissions on the selected controller.

4. To access the user maintenance controls, click Users. 

5. Choose a user from the list and click Change Password.

Figure 2-25 Change Password Dialog

6. Complete the Change Password dialog.

7. If the user has access to multiple controllers, check Change Password 
On All Servers. WallManager will check all connected controllers and 
update the password for all matching combinations of the user name and 
old password.

Edit User Information

1. Click the WallManager button and choose Security Settings.

2. Select the controller you want to work with.

3. If required, log in with an account that has User Maintenance 
permissions on the selected controller.

4. To access the user maintenance controls, click Users. 
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5. Choose a user from the list and click Edit.

Figure 2-26 Edit User Dialog

6. Complete the Edit User dialog.

NOTE: Any changes made to other user accounts take effect the next 
time the user starts WallManager. Changes to the current account take 
effect when you click OK.

Delete a User

NOTE: You cannot delete the last Level 1 user in the system.

1. Click the WallManager button and choose Security Settings.

2. Select the controller you want to work with.

3. If required, log in with an account that has User Maintenance 
permissions on the selected controller.

4. To access the user maintenance controls, click Users. 

5. Choose a user to be deleted from the list and click Remove.

6. Confirm the deletion.

2.2.6 Disable WallManager Security

Only a user with Level 1 security access can disable WallManager security.

1. Click the WallManager button and choose Security Settings.

2. Select the controller you want to work with.
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3. Log in with Level1 user account on the selected controller.

Figure 2-27 Security Settings Dialog

4. Uncheck the Enable Security option in the right panel.

NOTE: Disabling security does not delete the users and user information. If 
you enable security again, user information becomes active.

2.2.7 Manage Applications in WallManager

WallManager allows you to start applications on the display wall including 
MediaManager windows. Initially, WallManager scans the Controller’s Start 
Menu program list to identify applications that can be run. Review the 
preliminary list and remove from the list the applications that are not suitable 
for wall display.

• To remove an application from the list of available applications on 
page 2-28

• To change application properties on page 2-30

• To register an application on page 2-29

• To change application properties on page 2-30

• Application Details on page 2-30
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Edit the List of Registered Applications

1. If you have enabled security, sign on with an account that has 
Registered Application permissions.

Figure 2-28 Registered Applications Button

2. To access the Manage Registered Applications dialog, click the 
Registered Application button.

Figure 2-29 Manage Registered Applications Dialog
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To remove an application from the list of available applications 

1. Select the application and click Remove. The application moves to the 
Unavailable Applications list and cannot be included in scenarios.

Figure 2-30 Remove Registered Application

NOTE: To move an application back to the Available Applications list, select 
the application and click Restore.
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To register an application

1. In the Manage Registered Applications window, click New. The 
Details panel becomes active as the New Registered Application 
panel.

[

Figure 2-31 New Registered Application Panel

2. Complete the New Registered Application panel. For more information, 
see Application Details on page 2-30.

• Registered applications are run on the controller, therefore 
application path and working directory must be on the controller.

• If you are working remotely, you can check the presence and 
location of applications by viewing My Computer on the 
controller in Interactive mode. 

3. Click Save.

NOTE: When on the controller, the application details panel includes browse 
buttons for quick access to applications.

Figure 2-32 Registering Applications on the Controller
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To change application properties

1. Select the application and click Edit. The Details panel becomes active 
as the Editing panel.

Figure 2-33 Edit Registered Application Panel

2. Change the information as required and click Save to save the changes. 
For more information, see Application Details on page 2-30.

Application Details

This panel lets you specify files and switches required to run an application 
on the display wall. This detail information appears on the New 
Registered Application dialog and the Edit <application> dialog.

Name – Name identifies the application.

Application Path – Identifies the location of the application on the 
controller, for example C:\Program Files\Adobe\Acrobat\Acrobat.exe.

Command Line – Identify switches (for example, /s with .ppt files), start 
up files (for example, initialization, configuration, images, etc.), and data 
files (for example, .PDF, .xls, etc) required to run the application the way 
you want.
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Working Directory – The default working directory is the application 
directory. The working directory updates automatically if a data file in a 
different folder is specified in the Command Line field.

2.2.8 Manage Server Status Notification

You can use WallManager to set up TVC controllers to send notification of 
status changes to e-mail addresses you specify.

Set Up Status Notification E-mail Server

1. In WallManager, click the Controller Status tab. 

Figure 2-34 Configure E-mail Server Button

2. Click Configure. The Configure Notification E-mail Server dialog 
appears.

Figure 2-35 Configure Notification E-mail Server Dialog

3. Click Enable to activate the set up dialog.

4. Identify the E-mail Server to use for status notification e-mails.

5. Identify the From Address to send e-mail status notifications from. 
The address must be a valid e-mail address on the e-mail server.
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6. If your e-mail server requires authentication, check the 
Authentication Enabled checkbox and specify a valid e-mail user 
and password with permission to send e-mails.

7. Click Update.

Add a Status Notification E-mail Recipient

1.  Click Add. 

Figure 2-36 Add E-mail Notification Recipient Button

2. The Add Notification Recipient dialog appears. 

Figure 2-37 Add E-mail Notification Recipient Dialog

3. Enter the e-mail address of the recipient you want to add to the list.

4. Specify the language to use for the recipient.

5. Click Create.
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Remove a Status Notification E-mail Recipient

1. In the Recipients panel, select the e-mail address and click Remove.

Figure 2-38 Remove E-mail Notification Recipient Button

2. Confirm the delete.

2.2.9 Manage Device Tasks

You can create device tasks that specify an action to be performed on a 
device and include it in a scenario. For example, you can send instructions to 
a networked projector to close a shutter or power off. Device control should 
be reserved for Administrator level users who know and understand the 
serial command interfaces of their equipment. 

NOTE: For advanced projector setup and control functions, press Launch 
Display Control.

1. Click Device Tasks. 

Figure 2-39 Device Tasks Button
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The Manage Device Tasks dialog lists the device tasks defined for the 
selected controller.

Figure 2-40 Manage Device Tasks Dialog

2. To create a new task, complete the New Device Task panel.

• Name and describe the device task for easy recognition and use 
when constructing scenarios. 

• Ensure that the command is accurate.

• Ensure the communication information is correct. Contact your 
system administrator for communication settings.

NOTE: When you add a device task to a scenario, WallManager forwards 
the specified command to the device or devices at the specified COM port or 
IP address/port. WallManager does not know what the command is or the 
type of device receiving it. 

2.2.10 QuickLaunch

QuickLaunch can be installed on the desktop for quick and easy access to 
WallManager, WallViewer, RemoteControl, and WallManager scenarios. 

Figure 2-41 QuickLaunch Button Bar
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Install QuickLaunch

1. To install QuickLaunch from WallManager, click the WallManager 
button and select Client Applications. The Client Application dialog 
appears.

Figure 2-42 Client Applications Window

2. Click QuickLaunch. 

3. If security is enabled, log in using a valid user account on the controller.

The QuickLaunch bar and QuickLaunch shortcut appears on your 
desktop.

       

Figure 2-43 Initial QuickLaunch bar and 
QuickLaunch shortcut 
MASTERSuite 5.0 User Manual 2-35
020-100448-01 Rev. 1 (03-2010)



Section 2: Software Setup and Administration
Configure QuickLaunch

1. Right-click on QuickLaunch and select Configure. The QuickLaunch 
Configuration dialog appears.

s

Figure 2-44 QuickLaunch Configuration

2. Specify how you want QuickLaunch to look.

3. Check the items you want to appear on QuickLaunch.

NOTES: 1) The scenario list is retrieved automatically from the 
controller when you open QuickLaunch. 2) The Touchscreen option in 
the View panel makes the buttons larger so they are easier to work with 
on a touchscreen.

4. Click Save.

NOTE: The Host field allows you to change your server if you have 
more than one controller set up. 
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3 Showing Media on the 
Display Wall
MediaManager is a software application specifically designed for viewing 
video, RGB and remote desktop sources on a multi-display wall. 

3.1 About MediaManager

MediaManager is an interactive application. Changes made to the settings in 
MediaManager are seen immediately on the display wall. You can use 
MediaManager on its own or with WallManager, which adds the ability to 
schedule MediaManager windows and control the display wall remotely.

Adding to test reference function in robohelp.

3.1.1 Profile vs. Channel 

It is important to make the distinction between a Profile and a Channel, since 
these terms are used throughout the software menus and this manual.

A Channel represents a specific signal source, such as a camera, DVD 
player, PC on the network, etc. It stores all the optimized input settings for 
the source, such as its specific hardware connection, brightness, contrast, 
hue, etc. Channels can be uniquely named to make selection easier, 
eliminating the need to remember how the signal is connected and what 
input settings are associated with it. 

Channels can be created, copied, deleted, and edited. See 2.1.3 Manage 
Channels.

A Profile is a group of settings that describes what is shown in the window 
and how it is displayed. Such settings include window size, position, and 
style, as well as text overlay and content capture. Profiles allow you to 
quickly set up a display wall or change a display wall layout without having 
to reset window properties. A Profile can specify one channel to be 
displayed, or more than one channel to be cycled. 

Profiles are saved on the system’s hard drive as .xml files. The number of 
Profiles that can be created and stored is limited to the memory available on 
the hard drive. See 3.1.3 Profile Menu and 3.1.4 Settings Menu.
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3.1.2 MediaManager Layout

MediaManager is installed on the controller. It is accessed from the display 
wall desktop and opens on the display wall. You can access MediaManager 
functions through the menus.

Figure 3-1 MediaManager

Figure 3-2 MediaManager Menus

Shortcut keys are fully customizable. See 2.1.4 Hotkey Configuration.

You can optionally hide a MediaManager window’s menu bar by clicking 
Settings>Windows Preferences and selecting Borders Only or None 
on the Windows Preferences dialog. You can access the menu options by 
clicking the right mouse button anywhere in the MediaManager window. 
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Figure 3-3 Context Sensitive Menu (Right-Click)

3.1.3 Profile Menu

The Profile menu allows you to work with profiles.

New – Select this option to create a new profile. MediaManager assists you 
by stepping through the most commonly used dialogs.

Open – Select this option to load a saved profile. The Open dialog allows 
you to open the profile into the current window or into a new window.

Save – Select this option to save changes to an existing profile using the 
Save dialog. If you are not working with an existing profile, this option 
automatically opens the Save As dialog.

Save As – Select this option when creating a new profile or when you want 
to save an existing profile under a new name.

Create Shortcut – Select this option to create a shortcut to the current 
profile.

Manage Profiles – Select this option to manage your profile list. 

Exit – Select this option to close down the MediaManager window.

3.1.4 Settings Menu

The Settings menu allows you to work with all Channel options except 
Channel Cycling properties, which are under the Cycling menu.

Channel Selection – The Channel Selection dialog allows you to select a 
channel to be loaded in the current window, or into a new window.
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Window Preferences – The Window Preferences dialog allows you to 
specify the window size, position and style of the current MediaManager 
window. See Window Preferences Dialog on page 3-11 for more 
information.

Crop and Zoom – The Crop and Zoom dialog allows you to focus on a 
specific part of the window’s content. See Crop or Zoom the Image on 
page 3-9.

Text Overlay – Select this option to enable and set up the appearance of 
overlay text, and to specify the text for profile level overlays. For more 
information, see Text Overlay Dialog on page 3-14.

Current Channel Settings – Select this option to change channel settings 
of the currently displayed channel. The settings that can be changed depend 
on the channel’s device. See Channel Properties Dialog on page 2-6.

3.1.5 Capture Menu

The Capture menu allows you to set up and initiate image captures of the 
channel content.

Configure – Use these options to setup capture options.

• Single Frame – Select this option to set up image properties and 
storage location for single snapshots. See Single Frame Dialog on 
page 3-17.

• Multiple Frame – Select this option to set up image properties and 
storage location for image sets. See Multiple Frame Dialog on page 3-
19.

Single Frame – Select this option to capture an image of the current 
contents of the MediaManager window.

Start/Stop Multiple Frame – Select this option to start and stop the 
automatic capture of multiple images of the contents of the MediaManager 
window.

3.1.6 Cycling Menu

The Cycling menu allows you to control channel cycling in the 
MediaManager window.

Configure – Select this option to select and arrange channels to display in 
windows that see the current profile. 

Start/Stop Channel Cycling – Select this option to start and stop cycling 
through the channels associated with the current profile. This option is only 
available if more than one channel is specified in the profile’s cycling list.
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3.1.7 Administration Menu

Channel Configuration – Select this option to work with the channel list. 
The Channel Configuration dialog allows you to add, delete, and rename 
channels. It also allows you to open the Channel Properties dialog for the 
selected channel. See Channel Properties Dialog on page 2-6.

Setup Keyboard Shortcuts – Select this option to configure keyboard 
shortcuts for common tasks. 

Language – Select this option to change the language of the 
MediaManager displays. 

3.1.8 Capture to Window

Capture to Window captures an image of the MediaManager window and 
displays it automatically in a new window. The source MediaManager 
window continues to play.

3.1.9 Help Menu

Help Contents – Select this option to access the online help for 
MediaManager.

Diagnostics – Select this option to review information about the system. 

3.2 Working with MediaManager

MediaManager works behind the scenes with a virtual copy of a profile. You 
can manipulate the look and feel of the window through the interactive 
dialogs and then save the changes.

Clicking OK on MediaManager dialogs generally saves the changes to the 
virtual copy. To save the changes to file, click Profile>Save As or 
Profile>Save.

3.2.1 Start MediaManager

On the wall display desktop, double-click on the Christie MediaManager 
icon located on the desktop OR navigate through the Start menu to start 
using MediaManager. (Start>All 
Programs>Christie>MASTERSuite>Christie MediaManager.)

When you start MediaManager the default window appears. MediaManager 
is configured to display a blank MediaManager window. 
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3.2.2 Quick Start with Profiles

MediaManager provides some assistance for creating profiles for single-
channel display. It walks you through the dialogs most commonly used to set 
up a basic profile. 

To start, click Profile>New. The dialogs in the quick start are modified to 
include Next and Previous buttons, and prompt you to save the profile at 
the end. The Cancel button cancels the quick start.

• Channel Selection: See Select a Single Source on page 3-7

• Window Preferences: See Change the Style, Size, Position or Aspect 
Ratio on page 3-10

• Text Overlay: See Add a Text Overlay on page 3-12

• Single Frame Capture: See Capture a Snapshot Manually on page 3-16

• Multiple Frame Capture: See Capture Multiple Snapshots Automatically 
 on page 3-18.

For a complete list of setup tasks and options, see the introduction to 
3.2 Working with MediaManager. 

Select an Input Source for Display

MediaManager organizes input sources as channels. Each MediaManager 
window can display one input source, that is, one channel at a time. You can 
select multiple channels to be displayed in sequence.

• Select a Single Source on page 3-7

• Cycle Through Multiple Sources on page 3-8

NOTE: You can also load channels by loading a profile. If the profile has a 
list of channels, the first channel in the cycling list automatically displays in 
the MediaManager window. If the profile has only one channel, that channel 
is displayed.
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Select a Single Source

1. In the MediaManager window click Settings>Channel Selection. 
The Channel Selection dialog appears. 

Figure 3-4 Channel Selection

2. Select a channel and click Load Channel. The channel content appears 
in the MediaManager window.

3. To save the changes, click Profile>Save.

NOTE: You can refresh a channel by pressing CTRL-F5.

NOTE: A single display output can display multiple V9 channels if the 
channels are from the same input card.
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Cycle Through Multiple Sources

1. In the MediaManager window, click Cycling>Configure. The 
Cycling Configuration dialog appears.

Figure 3-5 Cycling Configuration

2. Click a channel to select it.

3. To add the selected channel(s) click Add.

NOTE: Select a channel in the lower list and click Remove to remove an 
item from the cycling list.

4. Specify the amount of time to display for the selected channels in the 
Channel Cycling List by entering a value in the Duration field and 
clicking Apply.

NOTE: You can have different display durations for specific channels or 
groups of channels.

5. You can use the Move Up and Move Down buttons to re-order the 
Channel Cycling list.

6. Click Start Cycle to begin cycling through the channels in the 
MediaManager window.

7. Click OK to close the dialog.

8. To save the changes, click Profile>Save.
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3.2.3 Change the Appearance of the Displayed Source

The Channel Properties window allows you to control the appearance of the 
source. For example, you can change the brightness, or the sample rate. 

Change Channel Properties

The Channel Properties window contains different properties for each of the 
device types. Changing a channel affects all profiles that refer to that 
channel.

1. Once you have selected a channel in the MediaManager window click 
Settings>Current Channel Settings. The Channel Properties 
dialog appears.

Figure 3-6 Channel Properties

NOTE: The contents of the Channel Properties dialog are different 
depending on the device type associated with the channel. See Channel 
Properties Dialog on page 2-6.

2. Adjust the channel properties. As you adjust channel settings, you can 
see the effect on the display wall.

NOTE: Profiles refer to channel names. Changing a channel name 
causes existing profiles that refer to the old name to display an “Invalid 
Input” message instead of the content. Rename channels with caution 
and remember to update your profiles.

3. Click Save to save the settings to a channel configuration file (.XML 
file).

NOTE: Click Cancel to return the settings to the most recently saved 
state.

Crop or Zoom the Image

Crop and Zoom settings allow you to trim or trim and zoom in on a portion 
of the window. These settings are saved for specific channels in a profile. 
The same channel can have different crop or zoom settings in different 
profiles, but each profile can have only one crop setting or one zoom setting.
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1. Once you have selected a channel in the MediaManager window, 

• CTRL + left-click, hold and drag the cursor to select the area to 
crop. When you release the mouse button, the window 
automatically resizes to the selected area. This key and mouse 
combination can be used without opening the Crop and Zoom 
dialog.

• ALT + left-click, hold and drag the cursor to select the area to 
zoom. When you release the mouse button, the contents 
automatically zoom in on the selected area. The window remains 
the same size. This key and mouse combination can be used 
without opening the Crop and Zoom dialog.

2. To save the changes, click Profile>Save. 

Notes: 1) Alternatively, you can access the Crop and Zoom dialog by 
clicking Settings>Crop/Zoom. In the Crop and Zoom dialog, enter the 
number of horizontal and vertical pixels you don’t want to see in the 
image by entering the values in the Top, Bottom, Right, Left text boxes 
or use the Up/Down arrow keys to incrementally increase the value. 2) 
You can reset to the original size by clicking the Reset button. 

3.2.4 Change the Appearance of the MediaManager 
Window

You can change the MediaManager window properties, for example by 
removing the title bar or adding a text overlay. Window properties remain 
effective for the window regardless of the channel (input source) being 
displayed.

Change the Style, Size, Position or Aspect Ratio

1. Click Settings>Window Preferences. The Window Preferences 
dialog appears. 

Figure 3-7 MediaManager Window 
Preferences
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2. Adjust the window settings to the desired size and position. You can see 
the changes immediately.

NOTE: You can optionally lock any of the settings that you adjust by 
checking the appropriate checkbox so that they cannot be changed 
accidentally.

3. In the Borders and Title Bar panel, select the desired window style.

NOTE: Removing the title bar also removes the menu bar. If you remove 
the title bar, you can still access all menu options by right-clicking the 
cursor anywhere in the MediaManager window. 

4. Click OK to accept the changes and close the dialog box.

5. To save the changes in the profile click Profile>Save.

Window Preferences Dialog

The Window Preferences dialog allows you to change the appearance of the 
MediaManager window.

Preset Size  – Use the drop-down menu to adjust the size of the 
MediaManager window to best suit your installation. Select the option 
Native Source (default) if you want to display the window based on the 
resolution of the input signal. Custom is automatically selected if the 
window size is scaled to another size not available from the option list. 
Select 1/4 Source, 1/2 Source, 2x Source or 4x Source to resize the window 
based on the size of the input signal.

When you select 1/3 Screen, 1/2 Screen, Single Screen or 2x2 Screen the 
incoming signal is resized based on screen size. For example, select 2x2 
Screen if you want to display any source signal across a 2x2 display wall, or 
if you have a single screen and four incoming signals, you can select 1/2 
Screen to display all four signals on one screen.

Aspect Ratio  – Use the Aspect Ratio drop-down menu to select the aspect 
ratio of the MediaManager window. The size of the MediaManager window 
automatically changes when a different aspect ratio is selected. The default 
aspect ratio setting is Device.

Check the Maintain Aspect Ratio check box to keep the window at the 
specified aspect ratio when scaling.

Position  – Use the text boxes, labeled X and Y, to enter coordinates that 
specify where the MediaManager window displays on the display wall. (The 
coordinates entered specify where the top left corner of the 
MediaManager window is located.) The default coordinates are 0,0.

Check the Lock Position check box to prevent moving the window to 
another position.
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Size  – Use the text boxes labeled Width and Height to specify the exact 
pixel size of the MediaManager window (content only) – some consideration 
should be given to the thin borders (4 pixels each side), title bar (depends on 
size of font) and caption bar. By default, the size is the native size of the 
window content. 

Check the Lock Size check box to prevent resizing the window.

Always on Top – Check this option to keep the current MediaManager 
window on top.

None – Select this option when you want to display the current contents of 
the window without borders. If you choose this window style, use the “right-
click” menu to access window options. 

Borders Only – Select this option to display the window with a thin border 
only, and without menu and title bar. If you choose this window style, use the 
“right-click” menu to access menu options.

Both (default) – Select this option when you want the MediaManager 
window menu and title bar to display. 

Add a Text Overlay

You can display text over the content in a window, for example to identify 
the source of the content. 

1. Click Settings>Text Overlay. The Text Overlay dialog appears.

Figure 3-8 Text Overlay
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2. By default, text overlay is disabled. To turn text overlay ON, select the 
type of overlay to use: Profile or Channel. 

• If you select Profile, the text is specified in the Overlay Text field. 
Type the text you want to appear over the channel content. The text 
appears in the MediaManager window.

• If you are specifying settings for channel-specific overlays, you do 
not need to specify the text. The text specified in each channel’s 
properties dialog is used. The default text string is the channel 
name. 

3. Adjust the appearance of the text overlay until you are satisfied with the 
look and position, and click OK to close the dialog. See Text Overlay 
Dialog on page 3-14. 

• All devices can display a transparent background for text overlays.

NOTE: The Text Preview panel does not scale text. For best results scale 
the MediaManager window to the source’s native size during Text 
Overlay setup. Set up the text overlay and check the Scale with Window 
option. Alternatively, you can make the window the desired size and set 
up the text overlay in an appropriate size.

4. To save the changes in the profile click Profile>Save.

5. If you chose to customize channel specific text overlays, see Customize 
Overlay Text to Channels on page 3-13.

Customize Overlay Text to Channels

You can customize text overlay content in a window, for example to identify 
the source of the content.

1. To specify text for multiple channels, click Administration>Channel 
Configuration. The Channel Configuration dialog appears. 

2. Click a channel to select it, and click the Edit button. The Channel 
Properties dialog appears. The Channel Properties dialog contents 
depend on the channel selected. See Channel Properties Dialog on 
page 2-6.
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Figure 3-9 Channel Properties

3. Enter the text in the Overlay Text field, and click Save.

4. Repeat steps 2 to 3 for each channel requiring customized overlay text.

5. Except for channel-specific text, text overlay information is defined and 
saved in the profile. To turn channel-specific text overlays ON and to 
edit the appearance of the text overlays, see Add a Text Overlay on 
page 3-12.

Turn Text Overlays ON or OFF

Text overlays are controlled in the Text Overlay dialog.

1. Click Settings>Text Overlay. The Text Overlay dialog appears. 

2. Select one of the options at the top of the dialog:

• Disabled: Turns text overlays OFF

• Profile: Displays the text specified on the Text Overlay dialog

• Channel: Displays the text specified in the Channel Properties 
dialog

3. Click OK to close the dialog.

4. To save the changes in the profile click Profile>Save.

Text Overlay Dialog

Enter the desired text in the Overlay Text field and click OK. By default 
the text appears centered at the bottom of the window. The text overlay 
information is stored with the profile.

You can optionally change the appearance of the text by adjusting a variety 
of settings on the Text Overlay window.

NOTE: You can also specify a separate text overlay for each channel. 

Disabled – Select this option to display no text overlay.

Profile – Select this option to display the text overlay specified on the Text 
Overlay dialog. 
3-14 MASTERSuite 5.0 User Manual
020-100448-01 Rev. 1 (03-2010)



Section 3: Showing Media on the Display Wall
Channel – Select this option to display the text overlay specified on the 
Channel Properties dialog. 

Overlay Text  – Enter the text you want to display with the selected source 
in the Overlay Text field. The overlay text appears in the Preview Text 
window below. 

Appearance Section – You can change the way the text looks and 
preview the changes as you make them.

• Select the style and size of your text from the Font and Size drop-down 
lists respectively.

• You can change the appearance of the text by checking the Bold, Italic, 
or Underline checkboxes.

• Enable the Scale with Window option to automatically resize the text 
overlay in relation to the window’s horizontal size. Scaling only 
changes the text in relation to the window’s horizontal size.

• Enable the Transparent Background option to float the text over the 
content without a background box.

• Click the Choose Foreground Color button to open a color selection 
window. Select the color you want and click OK. 

• Click the Choose Background Color button to open a color selection 
window. Select the color you want and click OK. 

NOTE: Background color is applied to the entire caption bar. 

• Enable Use Outline, to apply a thin, one-pixel outline around each 
character of the text overlay – this only applies to True Type fonts. 

• Click the Choose Outline Color button to open a color selection 
window. Select the color you want and click OK. Outline settings apply 
to True Type fonts only.

• Position the text overlay by clicking in the Preview Text panel. You 
can select one of the 15 preset locations by clicking the desired area in 
the window, or you can drag the text by clicking and holding while you 
move the mouse. Preset positions place the text overlay 5 pixels from 
the edge.

3.2.5 Capture Snapshots of the MediaManager Window

You can set up the system to capture snapshots of the content. 

This section includes the following:
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Capture a Snapshot Manually

You can capture a snapshot of the MediaManager window’s content at any 
time by pressing a combination of shortcut keys, for example CTRL+C. By 
default, the system stores snapshots in the C:\MyCaptures folder. You can 
customize the snapshot name and location. For more information, see Single 
Frame Dialog on page 3-17.

NOTE: Shortcut keys are customizable. For a current list of shortcut keys 
click Administration>Keyboard Shortcuts and view the list in the Keyboard 
Shortcuts dialog.

1. To configure single snapshots, click Capture>Configure>Single 
Frame. The Single Frame dialog appears.

Figure 3-10 Single Frame Capture

2. Identify the folder where snapshots are to be saved in the Folder 
Location field.

3. Identify a base name in the Base File Name field.

NOTE: Image file names are composed of a base name that you provide 
and a suffix. For example, if you provide the name Camera1 as the 
name for the snapshots, and select the sequence [base]_[1,2,3…], the 
first four snapshots will be called Camera1_1, Camera1_2, 
Camera1_3, and Camera1_4. If you specify “no sequence” only the 
base name is used and the image is replaced by each succeeding 
capture. 

4. Select the sequence numbering style in the File Name Sequence 
field.

5. Select the Image Type. When JPG is selected, you can specify the 
quality of the image captured, by entering a value from 1 to 100. In 
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general, the higher you set the value the better the image quality will be, 
and the larger the file size.

6. Click Capture to create a snapshot. The snapshot is displayed in the 
Preview panel. 

7. Click OK to close the dialog.

8. To save the changes in the profile click Profile>Save.

NOTE: You can scroll through all the images in the default directory by 
clicking the Previous and Next buttons.

Single Frame Dialog

The Capture Single Frame dialog allows you to set up and review single 
frame snapshots.

Folder Location – You can specify the location where the single capture 
image files will be stored. Use the Browse button to quickly navigate your 
file system to locate a specific folder. Click on the folder you want – the 
folder name appears in the Folder Location text box. 

Base Name – Enter the prefix you want to apply to your image captures in 
the Base File Name text box or use the default (“snapshot”). As each capture 
is taken a sequential number is automatically added to the base name. For 
example, if you enter the prefix “Camera1” into the Base File Name text 
box, and take 4 captures you might see the following in your capture folder: 
Camera1_1.jpg, Camera1_2.jpg, Camera1_3.jpg and Camera1_4.jpg. 

File Name Sequence – You can choose to include the date and time in 
your Filename. Click the file name sequence list and select the numbering 
style you want.

Image Type  – Enable BMP, PNG or JPG to specify which file format you 
want the image captures in. When JPG is selected, you can specify the 
quality of the image captured, by entering a value or using the up/down 
arrow keys under the Quality option. In general, the higher you set the value 
for Quality the better the image quality, and the larger the file size. Any 
value from 1 – 100 can be entered.

Preview – Review existing images in the Preview panel. Use the Preview 
and Next buttons to browse through your snapshots.

Capture – Use this button to capture a snapshot of the image in the 
window.

Discard – Use the Discard button to delete the image displayed in the 
Preview panel.
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Capture Multiple Snapshots Automatically 

You can start to capture a sequence of snapshots of the MediaManager 
window’s content at any time by pressing a combination of shortcut keys, for 
example CTRL+1. By default the system captures an image every 10 
seconds, and store sequences of snapshots in the C:\MyCaptures folder. 
Click CTRL+2 to stop the capture. You can customize snapshot frequency, 
location, storage limits, and file naming.

NOTE: Shortcut keys are customizable. For a current list of shortcut keys 
click Administration>Keyboard Shortcuts and view the list in the Keyboard 
Shortcuts dialog.

1. Click Capture>Configure>Multiple Frame. The Multiple Frame 
dialog appears. For more information about the fields, see Multiple 
Frame Dialog on page 3-19.

Figure 3-11 Multiple Frame Capture

2. In the Folder Location field, identify the folder in which all sequence 
subfolders are to be saved.

3. Identify a file name in the Base File Name field.

NOTE: Image file names are composed of a base name that you provide 
and a suffix. For example, if you provide the name Camera1 as the 
name for the snapshots, and select the sequence [base]_[1,2,3…], the 
first four snapshots are called Camera1_1, Camera1_2, Camera1_3, 
and Camera1_4. If you specify “no sequence” only the base name is 
used and the image is replaced by each succeeding capture.

4. Select the sequence numbering style for the images in the File Name 
Sequence field.

5. Identify a folder name in the Base Folder Name field.

6. Select the sequence numbering style for the folders in the Folder 
Name Sequence field.

NOTE: The folder name sequence allows you to indicate when a new 
folder should be started. New folder names are built from the base name 
and the date and or time sequence selected. For example, if you provide 
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the name Camera1 and select [base]_[date] (new folder at midnight) a 
new folder is created at midnight with a name like Camera1_2005_4_1. 

7. Select the Image Type. When JPG is selected, you can specify the 
quality of the image captured, by entering a value from 1 to 100. In 
general, the higher you set the value the better the image quality, and the 
larger the file size.

8. Identify how often to take a snapshot in the Capture Every field.

9. Identify how many snapshots should be stored in the Capture Limit 
field.

10. Click Start to begin taking snapshots or OK to save the settings and 
dismiss the dialog.

11. To save the changes in the profile click Profile>Save.

Multiple Frame Dialog

The Multiple Frame dialog allows you to automate the process of image 
capture by specifying a timed interval.

Folder Location – Use the Browse button to quickly navigate your file 
system to select where you want your image capture folders to be stored. 

Base Folder Name – Specify a name for the subfolders. 

Folder Name Sequence – You can choose to include the date and time in 
your subfolder name. Click the folder name sequence list and select the 
numbering style you want.

Base File Name – Enter the prefix you want to apply to your image 
captures in the Base File Name text box or use the default (“image”). As 
each capture is taken a sequential number is automatically added to the base 
name. For example, if you enter the prefix “Camera1” into the Base File 
Name text box, and take 4 captures you will see the following in your 
capture folder: Camera1_1.jpg, Camera1_2.jpg, Camera1_3.jpg and 
Camera1_4.jpg. 

File Name Sequence – You can choose to include the date and time in 
your Filename. Click the file name sequence list and select the numbering 
style you want.

Image Type  – Enable BMP, PNG or JPG to specify which file format you 
want the image captures in. When JPG is selected, you can specify the 
quality of the image captured, by entering a value or using the up/down 
arrow keys under the Quality option. In general, the higher you set the value 
for Quality the better the image quality, and the larger the file size. Any 
value from 1 – 100 can be entered.
MASTERSuite 5.0 User Manual 3-19
020-100448-01 Rev. 1 (03-2010)



Section 3: Showing Media on the Display Wall
Capture Every – Use this option to specify how often the system should 
save a snapshot. You can specify the frequency in number of seconds or in 
number of frames.

Capture Limit – Use this option to specify how many snapshots the system 
should save. 

• Select None when you want the software to continue capturing images 
at the specified frequency until there is no hard drive space available. 

• Select Limited To when you want to limit the number of images saved.

• Specify the image capture time span in number of seconds, minutes, 
hours, or frames.

• Specify the maximum amount of disk space to be used. 

• By default, image capture stops when a limit is reached. Enable the 
Continuous checkbox to continue capturing. Once a limit is reached, 
the capture process loops back and begins overwriting the oldest files 
already captured in the series.

OK – Click this button to save the automatic capture setup.

Start/Stop Capture – Click this button to start and stop capturing a series 
of snapshots.

3.2.6 Save Current MediaManager Window Settings as a 
Profile

When you are satisfied with the way the MediaManager window looks, you 
can save your settings to a MediaManager profile.

• To save a new profile, click Profile>Save As and specify a name for 
the new profile in the space provided. Click OK.

• To save over the current profile, click Profile>Save. The settings are 
automatically saved to the current profile. If the MediaManager window 
has not been saved, the Save As dialog appears.

3.2.7 Create a Shortcut to Open a MediaManager Window

Once you have saved a MediaManager profile, you can create a desktop 
shortcut to launch a MediaManager window using the saved profile.

1. In the MediaManager window, click Profile>Create Shortcut. The 
Save Shortcut dialog opens. 

2. Browse to the location you want to save the shortcut to, and click Save.
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3.2.8 Open an Existing Profile

1. Click Profile>Open. The Open dialog appears.

Figure 3-12 Open Profile

2. Select a profile and click Load Profile. The MediaManager window 
changes to reflect the settings specified in the profile, and the contents 
of the first channel in the profile automatically displays.

3.2.9 Modify an Existing Profile

1. Open a MediaManager window with the profile you want to change.

2. Modify the profile settings. You can change channel and window 
settings.

3. Once you have configured the current MediaManager window to 
your satisfaction, click Profile>Save to overwrite the current profile. 

3.2.10 Manage Channels 

The Channel Configuration dialog is accessed from the Administration 
menu. It allows you to quickly edit an existing channel; add, copy, or delete 
channels; or restore all default channels. For more information, see 
2.1.3 Manage Channels.
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4 Managing the Display 
Wall
Once media channel and profiles (MediaManager), and scenarios 
(WallManager) are set up you can access and control the display wall in a 
number of ways.

Table 4.1 Remote Operation Functions

Application Functionality Remote Views

WallManager • Installation required on 
remote PC

• Full scenario management 
including create, edit, 
schedule, start, stop

• Full interaction including 
working with applications 
directly on the controller

• Manage registered 
applications and device tasks

• Manage remote access 
security

• Integrated projector 
management

• Install client applications

• Server status

• Manage server status 
notifications

• Backup/restore settings

• Lockdown Mode

• Manage multiple controllers 
from one machine

• Wire outline 
of display 
elements

• Full LiveView 
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Application Functionality Remote Views

Remote 
Desktop 
(VNC)

No

WallViewer • Web-based, no installation 
required

• Start/stop existing scenarios 
and tasks

• Re-arrange scenario 
elements on the display wall

• Install client applications

• Server status

• Backup/restore settings

• Lockdown Mode

• Wire outline 
of display 
elements

• Window-
based 
LiveView

WallLaunch • Start/stop existing scenarios No

QuickLaunch • Start existing scenarios

• Start WallManager, 
WallViewer, and 
RemoteControl

No

Remote 
Control

• Control the TVC controller 
with a remote PC’s mouse 
and keyboard. Assumes a 
direct view of the display 
wall.

No

RS232 
Control 
Server

• Start/stop existing scenarios

• Switch channels in running 
MediaManager windows

No

Table 4.2 Remote Desktop Display

• Configure communication so 
that the remote PC desktop 
can be mirrored in real time 
in a MediaManager window 
on the display wall

• Can share control of remote 
desktop with controller’s 
mouse and keyboard

Table 4.1 Remote Operation Functions

Application Functionality Remote Views
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4.1 About WallManager

WallManager is a “client-server” software package providing powerful and 
flexible remote management of tiled multiple display walls. Use 
WallManager to manage users, remote access security, launch and control 
applications on the display wall, schedule scenarios, and perform other 
related functions. 

WallManager includes the following functionality:

• Monitors and handles communication between the TVC controller and 
client NT/2000/XP workstations

• Launches applications on the display wall as requested from clients

• Monitors the network clock for scheduled scenarios

The WallManager comes installed on your controller. It stores all user, task, 
projector, and schedule information as XML files on the controller. Christie 
services must be running on the controller for the WallManager client 
software to work. See 7.4.1 Scenarios.

PowerTool integration provides access to projector control. See the 
PowerTool User Manual for more information.

4.2 WallManager Layout

WallManager’s ribbon interface provides easy access to display wall 
controls, controller status, and scenario management controls. 

Figure 4-1 New Installation of WallManager
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Right-Click Menu

Context sensitive right-click menu provides access to functionality based on 
mode and window content. 

• Right-click on a view in wire frame or Live View mode to access a 
subset of the Controller Views options. See Controller Views for 
information about individual options.

• Right-click on a view in Interactive mode to access the right-click menu 
of the element on the controller desktop. For example, right-click on a 
MediaManager window in the controller view opens the MediaManager 
context menu.

4.2.1 WallManager Button Menu

Click the WallManager button to access the menu.

Figure 4-2 WallManager Button Menu

Save Settings/Save Settings As – Use these options to back up 
WallManager preferences and settings for the selected controllers. The 
default file name includes the system date.

Restore Settings – Opens the Restore Controller Settings dialog where 
you can specify the restores files for the selected controllers.

Security Settings – Opens the Security Settings dialog where you can 
manage WallManager security for remote access to the selected controllers. 
See WallManager Security on page 2-17.

Install Client Applications – Opens the Client Applications window 
where you can install client applets, such as the Christie QuickLaunch bar 
and RemoteControl. See Client Applications Dialog on page 4-5.

Close Controller Views – Closes all active controller views. It does not 
affect the operational state of the controllers.

WallManager Options – Opens the options dialog.

Popular>User Name/Initials – Identifies the primary user of the 
WallManager software.

Popular>Language – Identifies the language WallManager uses.
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Save>Restore – Identifies the default storage location for backup 
files.

Exit WallManager – Closes WallManager. Closing WallManager does not 
shut down the display wall.

Client Applications Dialog

Figure 4-3 Installing Client Applications

Connect RemoteControl  – Installs RemoteControl which allows you to 
control the display wall with your remote mouse and keyboard.

QuickLaunch – Installs QuickLaunch bar on your desktop for easy access 
to the WallManager functions you need most. The QuickLaunch bar is 
configurable.

Install WallLaunch – Installs WallLaunch on your desktop for easy access 
to the Scenarios on the controller.

Install RemoteDesktop Client – Installs RemoteDesktop Client and use 
your desktop as a source for MediaManager on the display wall.

Install WallManager Prerequisites – Installs the supporting software for 
WallManager.

Install WallManager – Installs WallManager for remote access and 
control of the display wall. Ensure that the supporting software is installed 
before starting this installation.

Install PowerTool – Installs PowerTool for access and control of display 
projectors.
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4.2.2  Controller Tab

WallManager opens automatically at the Controller tab. The controller tab 
provides a real-time, live representation of the display wall.The Controller 
ribbon includes controls for connecting to and managing multiple display 
walls.

Controllers

Figure 4-4 Expanded Controllers Panel

Controller Gallery – Identifies the TVC controllers that have been added 
to the WallManager application. A lock on the controller icon indicates that 
the controller requires a valid user name and password. Click an icon to open 
a view for the controller on the WallManager workspace.

Add – Opens the Select Network Computer list. The list contains all the 
networked computers in your domain.

Logout All – Logs out of and closes all controllers that have security 
enabled. 

Remove – Removes the selected controller from the panel.

Controllers Views

Figure 4-5 Expanded Controller Views Panel

Live View – Toggles Live View mode for the selected controller views. 
Live View mode shows the contents of the display wall in real time. When 
Live View is enabled, selected windows are outlined in yellow.

Interactive Mode – Toggles Interactive mode for the selected controllers. 
Interactive mode shows the contents of the display wall in real time and 
allows you to interact with application on the desktop as if they were running 
on your PC, including context sensitive right-click menus.The quality of the 
interaction depends on your network speed. When Interactive mode is 
enabled, selected windows are outlined in blue.

Lockdown Mode – Toggles Lockdown mode for the selected controllers. 
Lockdown mode logs out all remote WallManager users with permissions 
less than Level1. Users cannot sign back in until Lockdown mode is turned 
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off. Scheduled scenario starts are suspended as well. When Lockdown mode 
is enabled, the controller view in the WallManager workspace is outlined in 
red. The red outline does not appear on the display wall. 

Wall Magnification – Opens the Wall Magnification tab where you can 
select an area on the display wall to magnify. For more information, see 
4.2.3 Wall Magnification Tab.

Screen Capture – Captures the selected display wall at the controller’s 
native resolution. The image is saved as a .bmp file. Neither Live View nor 
Interactive mode are required to capture a display wall. If multiple 
controllers are selected, the last controller selected is captured. 

Select All – Opens a view of each connected controller in the Controllers 
panel and selects the views for further action. If security is enabled, 
WallManager prompts you to log in for each secured controller.

Select None – Deselects all the controller views.

Hide All – Closes all the controller views. Does not log out or disconnect 
from the controllers.

Fit to Screen – Fits the selected view or views to the workspace area. 
When multiple views are selected, the layout of the group is fit to the space 
without altering proportions or layout.

Cascade – Arranges the selected views in a cascade without adjusting size.

Side by Side – Arranges the selected views side by side.

Align Top/Bottom/Center – Aligns the selected views along the top 
or bottom edge, or along the midpoint of each view.

Full – Arranges the selected views side by side, matches and maximizes 
the sizes for best fit in the workspace.

Scenarios 

Figure 4-6 Expanded Scenarios Panel

Scenario Gallery – Identifies the scenarios you have access to. If security 
is not enabled, all scenarios on the selected controllers appear in the list. If 
security has been enabled, the list includes scenarios associated with the 
current user, and the scenarios created by users whose security level is the 
same as or lower than the current user.

Start – Starts the selected scenario immediately. If multiple controllers are 
selected, the selected scenario will start on all the controllers that have the 
scenario.
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Stop – Stops the selected scenario immediately. If multiple controllers are 
selected, the selected scenario will stop on all the controllers that are running 
the scenario.

Minimize – Minimizes the windows associated with the selected scenario to 
the controller task bar.

Restore – Restores the minimized windows associated with the selected 
scenario.

Details – Opens the Scenario Details dialog which contains information 
about the scenario including a list of tasks and scheduling information.

New Scenario – Opens the scenario editor at a blank layout for the selected 
controller.

Delete Scenario – Deletes the selected scenario from the selected 
controllers. 

Edit Scenario – Opens the scenario editor for the selected scenario.

Schedule – Opens the Schedule menu for the selected scenario. The menu 
identifies the controller.

List of Schedules – Lists the schedules defined for the scenario. Each 
schedule is indicates the schedule type, for example, once or daily.

Add – Opens the scheduling dialog. See Schedule Dialog on page 4-10.

Displays

Displays – Provides access to PowerTool in which you can set up 
and control the projectors in the display wall. See the PowerTools 
User Manual. 

Manage

Figure 4-7 Manage Panel

Register Applications – Opens the Manage Registered Applications 
dialog which lists the applications that can be run on the display wall. You 
can edit the existing list, or an individual application’s properties. The list is 
compiled automatically based on the contents of the controller’s Program 
Files directory. MediaManager is automatically registered. See 
2.2.7 Manage Applications in WallManager.

Device tasks – Opens the Manager Device Tasks dialog which allows you 
to create device tasks that can be included in scenarios. See 2.2.9 Manage 
Device Tasks.
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WallManager Workspace

The controller views in the workspace display real-time representations of 
the information shown on the display walls in wire frame, Live View, or 
Interactive mode. The default wire frame view shows the outlines and layout 
of active windows.

Figure 4-8 Workspace Zoomed In on One Controller View

Quick Access Buttons (at the top left of a view window) – Provide quick 
access to key view functions (Log Out, Live View, Interactive Mode, 
Lockdown Mode, and Wall Magnification, see Controllers Views on page 4-
6), and additional visual feedback about the state of the controller. The 
button backgrounds of active modes turn from transparent to orange.

Local Alias – Highlight the controller name in the controller view title bar 
and type a new name. The local alias is used to identify the controller for the 
current PC only. To view the server name, open the Controllers gallery and 
hover the mouse cursor over the controller button. A popup briefly displays 
available information about the controller including the server name.

Mouse Functions

Move Window – In wire frame and Live View, click and drag a 
window to its new location. In Interactive mode, treat windows as you 
would applications on your desktop. For example, click and drag the 
title bar to a new location.

Resize Window - Click and drag a window border or corner to resize a 
window.

Scroll – Use the mouse wheel to scroll up or down, or use the scroll bars 
to reposition the part you want to see.

Zoom – Hold down the Ctrl key and use the mouse wheel to zoom in or 
out. Use the scroll bars to reposition the part you want to see. See also 
Zoom Buttons.
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Zoom Buttons – Use the zoom in (+) and zoom out (-) buttons at the 
bottom right of the WallManager window to adjust the size of the image of 
the display wall in order to see details and work with applications. Use the 
scroll bars to reposition the part you want to see.

LiveView Speed – When using LiveView or Interactive mode this slider 
adjusts the frequency of background image updates. Move the slider to the 
left to slow down updates or to the right to speed up updates. 

• A higher frequency of updates keeps the display wall image more up-to-
date and reflects a faster response time when working with applications 
in the WallManager window. However, this uses more of your system 
resources (CPU and RAM), and can slow down application response 
times for WallManager and other applications running at the same time.

• A lower frequency of background image updates uses fewer resources, 
but may slow down the display of feedback for working with 
applications in the WallManager window, and it may introduce artifacts 
such as ghost dialog boxes when a dialog is moved.

View Context Menu

Figure 4-9 Controller View Context Menu

Fit Controller View to Screen – Fits the controller view to the 
workspace.

Live View, Lockdown Mode, Interactive View, Wall Magnification 
– See Controllers Views on page 4-6.

Bring to Front – Brings the selected window on top of other windows.

Send to Back – Sends the selected window behind other windows.

Close – Closes the selected window.

Schedule Dialog

Controller Time – Shows the date and time on the selected controller.

Start – Identifies the start time of the schedule. Click the arrow to view a 
calendar for date selection. Edit the Time directly.

Stop – Identifies the stop time of the schedule. Click the arrow to view a 
calendar for date selection. Edit the Time directly.
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Recur – Indicates how often the schedule recurs.

Delete – Deletes the current schedule.

4.2.3 Wall Magnification Tab

Wall Magnification allows you to identify an area on the display wall to 
magnify. The magnification window can be directly over the specified area 
or it can be moved to the side.

Figure 4-10 Wall Magnification Tab

Settings

Figure 4-11 Settings Panel

Magnification Level – Indicates how many times the area will be 
enlarged.

Movable Magnifier – Indicates where the magnifier can be moved to 
enlarge a different area of the display wall. 

• Check to make the magnification area moveable. Moving the 
enlarged view window moves the magnification area and changes 
the contents of the view window.

• Uncheck to anchor the magnification area to the original position. 
Moving the enlarged view does not change the contents.
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Magnification Window Size and Location

Figure 4-12 Magnification Window Size
 and Location Panel

Window Width/Height – Identify the dimensions of the area being 
magnified.

Window Position X/Y – Identifies the position of the top left corner of the 
area.

Launch

Launch – Launches the magnification window on the display 
wall. 

Enlarged View Window

You can work with the magnification window in Interactive mode. Click 
Options in the top left corner to get the following options:

Figure 4-13 Magnification Options

Always on Top – Indicates whether the magnification window should be in 
front of all other windows.

See Through Window – Indicates whether the magnification window 
should be transparent.

Zoom – Changes the level of magnification.

Save Configuration Settings – Saves the current settings to a 
configuration file. Use the configuration file information to create magnified 
views for scenarios.

Exit – Closes the magnification window.
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4.2.4 Edit Scenario Tab

The Edit Scenario tab allows you to create and edit collections of 
applications, media windows, and tasks that can be saved and scheduled. 
When you create a scenario, the workspace is blank. When you edit a 
scenario, application and media windows display in the workspace. 

Figure 4-14 Scenario Editor

Device tasks, Stop scenarios, and Minimize tasks do not display in the 
graphical workspace. To view a list of elements in the scenario including 
device tasks, click the List View button at the lower right of the workspace.

Figure 4-15 Scenario Editor, List View
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Scenario

Figure 4-16 Scenario Panel, Expanded

Save – Saves changes to an existing scenario.

Save As – Opens the Save As dialog where you can specify a name for the 
scenario.

Close – Closes the Edit Scenario tab.

Edit

Figure 4-17 Edit Panel

Cut/Copy/Paste – Cut and paste items in the scenario using these standard 
commands.

Delete – Deletes the selected window(s).

Select All – Selects all items in the Scenario.

Deselect – Deselects items in the Scenario.

Show Active Windows – Shows what is currently displayed on the 
display wall. 

Snapshot – Captures the windows currently showing on the display wall 
and adds them to the scenario. Adds the captured applications to the 
registered application list if they are not already there. 

Scenario Properties – Opens the Properties dialog for the scenario.

Name – Identifies the scenario.

Date Created – Indicates when the scenario was created.

Date Modified – Indicates when the scenario was last edited.

Modified By – Identifies who edited the scenario.

Description – Displays the short description provided when the 
scenario was created.

Task List – Shows the tasks that comprise the scenario.

Schedule – Shows scheduling information for the scenario.
4-14 MASTERSuite 5.0 User Manual
020-100448-01 Rev. 1 (03-2010)



Section 4: Managing the Display Wall
Window Properties – Opens the Application Properties dialog for the 
selected window. 

Name – Identifies the application.

Command Line – Identifies command line arguments such as the file 
to load.

Working Directory – Identifies the working directory for the 
application.

Window Preferences – Identifies the size and position of the 
application window.

NOTE: If the selected window is a MediaManager window, this option opens 
the Window Profile Settings dialog. For information about individual 
settings, see Working with MediaManager on page 3-5.

Arrange

Figure 4-18 Arrange Panel, Expanded

Top Row 

Align – Select two or more windows and click the align button 
to align all of the windows with the first selected window. The 
button shows the current alignment option. Click the arrow 
beside the button to show all the alignment options.

Same Size – Select two or more windows and click one of 
the Size options to resize the selected windows according to 
the sizing of the first selected window.

Fit to Display – Fit the selected window to the display.

Full Screen – Fit the current window to the display wall.

Bottom Row

Snap to Grid – Toggles forcing windows to snap to the underlying grid.

Snap to Display – Toggles forcing windows to snap to the closest display.

Snap to Active Windows – Toggles forcing selected windows in the 
scenario to snap to the closest active window.

Snap to Scenario Windows – Toggles forcing selected windows to snap 
to the closest window in the scenario.

Bring to Front – Moves the selected windows on top of other windows.

Send to Back – Moves the selected windows behind other windows.
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Insert

The Insert panel provides access to the elements that can be included in a 
scenario.

Figure 4-19 Insert Panel, Expanded

Registered Applications – Lists the applications that are available to be 
included in scenarios. Also provides access to application management, see 
Manage Applications in WallManager on page 2-26.

Media Sources – Lists the channels and profiles that have been defined in 
MediaManager for the current controller. See 2.1.3 Manage Channels.

Scenarios – Lists the existing scenarios on the current controller. 

Device Tasks – Lists the device tasks that have been defined on the current 
controller and provides access to device task management. See 
2.2.9 Manage Device Tasks. 

Stop Scenarios – Lists a Stop task for each scenario on the controller and 
includes a Stop All Scenarios option. Use this list to identify the scenarios 
that should be stopped before the current scenario is run.

Minimize Tasks – Lists a Minimize task for each scenario on the controller 
and includes a Minimize All Scenarios option.

Security Access

Figure 4-20 Security Access Panel, Expanded
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Security Access – Indicates which permission groups will have access to 
the scenario. All users with higher permissions than the creator 
automatically have access. Level l users always have access to everything. 
Checking a user level also indicates what that permission group sees. For 
example, Figure 4-20 indicates that Level three users only see the top left 
quadrant of the display wall.

Edit Context Menu 

The Editing workspace includes a context sensitive menu that provides 
quick access to the commands in the ribbon. Right-click in the workspace to 
view available commands.

4.2.5 Controller Status Tab

The Controller Status tab displays a summary of the current status of the 
TVC controller and provides access to controller status notification 
maintenance.

Figure 4-21 TVC Controller Status Tab
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Controllers

Figure 4-22 Expanded Controllers Panel

Controller Gallery – Identifies the TVC controllers that have been added 
to the WallManager application. A lock on the controller icon indicates that 
the controller requires a valid user name and password. Click an icon to view 
the controller’s status.

Add – Opens the Select Network Computer list. The list contains all the 
networked computers in your domain.

Remove – Removes the selected controller from the panel.

Logout All – Logs out of and closes all controllers that have security 
enabled. 

Recipients - E-mail Notification of Status

Figure 4-23 Recipients Panel

Recipients Gallery – Lists the e-mail accounts to be notified when the 
status of a component changes.

Add – Opens the Add Notification Recipient dialog box.

E-mail Address – Identifies the e-mail address to be notified.

Language – Identifies the language to be used for the notification.

Remove – Removes the selected e-mail address from the list.

Edit – Opens the Edit Notification Recipient dialog box.

E-mail Address – Identifies the e-mail address to add to the 
notification list.

Language – Identifies the language to be used for the contact.

Configure – Opens the Configure Notification E-mail Server where you 
can identify the e-mail server to use and the credentials required to access 
the e-mail server.

Enable – Enables e-mail notification of controller status changes.

E-mail Server – Identifies the e-mail server to use to notifications.

From Address – Identifies the e-mail address to send the notifications 
from.
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Authentication Enabled – Enables or disables e-mail authentication. 
Enable this option if the e-mail server requires authentication. If you 
enable this option, you must fill in the User Name and Password.

User Name – Identifies the user account to use for authentication on 
the e-mail server.

Password/Confirm Password – Identifies the user account 
password.

4.3 Working With WallManager

This section provides information about getting content displayed on the 
display wall:.

Notes: 1) See 2.2 WallManager Setup for information about administrative 
tasks; such as creating new WallManager users, registering applications and 
changing security options. 2) See 5 Remote Operation Client PC for 
information about interacting with the wall from a remote workstation.

4.3.1 Start WallManager

WallManager can be run on the controller or on a client workstation. 

1. Ensure that the TVC controller(s) and the display wall(s) are powered 
on.

2. Start WallManager:

• To start WallManager on the controller, click on the Christie 
WallManager shortcut from the desktop. 

• To start WallManager on a client workstation, click 
Start>Programs>Christie>MASTERSuite>WallManager.
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On initial startup, the Controllers panel will be empty.

Figure 4-24 Add Controller to WallManager

NOTE: If WallManager fails to run, ensure that .NET 3.1 SP1 has been 
installed. If not, click the WallManager button>Client 
Applications>WallManager Prerequisites to install it.

3. To add a controller to WallManager desktop click the Add controller 
button. WallManager detects visible networked computers.

Figure 4-25 List of Networked Computers

4. Select the controller from the list and click OK. The controller is added 
to the Controller gallery. Complete this step even if you are working on 
the controller.
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Figure 4-26 Controller Added to WallManager

NOTE: If your controller does not appear in the list, enter the controller 
name or IP address manually. If you still cannot connect, contact your 
system administrator. 

5. To connect to the controller and display an outline of the associated 
display wall, click the controller icon.

Figure 4-27 Connected Controller
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NOTE: If WallManager security is enabled, enter a valid user name and 
password. 

Figure 4-28 Security Login

NOTES: 1) To install QuickLaunch, see 2.2.10 QuickLaunch. 2) For 
information about starting scenarios and tasks, see 4.3.7 Start a Scenario.

4.3.2 Create a New Scenario

You can build a scenario from scratch or you can capture the current wall 
display layout.

The scenario editor makes a temporary record of the scenario as you build it. 
If you leave the editor to view other information in WallManager you are 
prompted to save the scenario. 

NOTE: If security is enabled, you must login with Edit Scenario permission 
in order to access the scenario editor.

Build a New Scenario 

1. In WallManager, click to select the controller you want to work with.

2. In the Scenarios panel, click Add. 

Figure 4-29 Expanded Scenarios Panel

The scenario editing window appears. 
4-22 MASTERSuite 5.0 User Manual
020-100448-01 Rev. 1 (03-2010)



Section 4: Managing the Display Wall
Figure 4-30 Scenario Editor

3. To add a media or application window to the scenario, click the 
Registered Applications, Media Sources, or Scenarios button in 
the Insert panel and select the element to add. 

4. Click and drag windows to position them for the scenario.

5. Click and drag window edges and corners to size the windows or use the 
Arrange panel to control your layout. See Arrange on page 4-15.

6. Right-click the application or media window and select Properties. 
The appropriate Properties dialog appears. Configure the application or 
media window as required:

• Application settings, see Application Details on page 4-24.

• MediaManager settings, see MediaManager Details on page 4-24.

7. When you are satisfied with your layout, click Scenario panel>Save 
As.

8. Enter a name for the scenario and click OK to confirm.

9. To save a copy of the scenario on an additional controller, check the 
Export To option in the Save As dialog and select a controller. All 
connected controllers are listed.

NOTE: You can display wire frames for the applications currently running 
on the display wall to help you position additional applications around them. 
Click Edit Panel>Show Active Windows.
MASTERSuite 5.0 User Manual 4-23
020-100448-01 Rev. 1 (03-2010)



Section 4: Managing the Display Wall
Application Details

Specify a working directory and command line parameters in the Working 
Directory and Command Line fields as required, and click OK. 

Command Line parameters can include start up files (for example, 
initialization, configuration, images, etc.) and data files (for example, .pdf, 
.xls, etc.).

MediaManager Details

Media sources include configured profiles, as well as default profiles for 
each available channel.

For each MediaManager window you want to include in the scenario, 
WallManager automatically applies any channel and profiles settings you 
have set up in MediaManager. You can review and change them using the 
Windows Profile Settings dialog.

 
Figure 4-31 Window Profile Settings

A number of settings are not applied because they do not make sense in the 
context of scheduled scenarios. For example, the ability to review a snapshot 
has been removed from the Single Capture tab.

The Appearance panel on the Text Overlay tab has been streamlined in the 
WallManager version, functionality remains the same.

See 3.2 Working with MediaManager for information about the individual 
settings. 
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NOTE: Changes implemented using this dialog are saved with the scenario 
only. To change a profile permanently, you will need to work with the full 
version of MediaManager on the controller.

Scenario Details

You can add an existing scenario to a new scenario in the same way that you 
add applications and media sources, by clicking a scenario in the list. When 
you add a scenario, the windows and tasks are added to the current scenario. 
No connection to the selected scenario is maintained, that is, the scenario 
that was included can be changed or deleted without affecting the current 
scenario.

Create a New Scenario From a Snapshot

When creating a scenario from a snapshot, WallManager ignores windows 
associated with the operating system. For example, it does not capture 
Explorer folders. To include an Explorer window in your scenario, add it 
manually. 

1. In the Controller tab, lay out the display wall the way you want it to 
look:

• Start applications and media windows on the controller desktop 
directly as you would applications on your remote PC.

• Start scenarios and work with the scenario windows. See 
4.3.8 Arrange the Display Wall in Real Time.

2. In the Scenarios panel click New Scenario.

3. In the Edit Scenario tab, click Edit Panel>Snapshot. WallManager 
captures the applications and media windows running on the display 
wall. Each window is automatically configured with its proper program 
name, working directory, and current position and size. 

4.3.3 Add a Device Task to the Scenario

Note that Device tasks setup is an advanced administrative feature which 
requires knowledge about the use of serial commands. For information about 
creating device tasks, see 2.2.9 Manage Device Tasks.
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Add a Device Task

WallManager allows you to include device tasks in addition to projector 
tasks. For example, you can include a task in a scenario to turn on a 
projector, or adjust the room lighting.

Figure 4-32 Device Tasks Button

1. In the Edit Scenario tab, click Insert>Device Tasks and select a task 
from the list.

2. Check the Device task in the List View.

Figure 4-33 Scenario Editor, List View

Remove a Task

To remove a task, select the task in the List View and press Edit 
panel>Delete.

4.3.4 Add a Stop Scenario Task to the Scenario

Scenarios can include Stop Scenario tasks. These tasks specify scenarios that 
will be shut down before the new scenario is started.

Figure 4-34 Stop Scenario Tasks Button

1. To include a Stop Scenario task, open the scenario for editing.

2. Click Insert>Stop Scenarios and select a scenario from the list.
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The task is added to the scenario List View.

4.3.5 Add a Minimize Task to the Scenario

Scenarios can include Minimize tasks. These tasks specify scenarios that 
will be minimized to the task bar when the new scenario is started.

Figure 4-35 Minimize Scenarios Button

1. To include a Minimize task, open the scenario for editing.

2. Click Insert>Minimize Tasks and select a scenario from the list.

The task is added to the scenario List View.

4.3.6 Open a Scenario for Editing

You can edit an existing scenario to add or remove windows, change 
position or sizing. If security is enabled, you must login with Edit Scenario 
permission in order to access the scenario editor.

1. In WallManager, click the Controller tab. 

2. On the Scenarios panel click the scenario you want to edit.

3. In the right panel, click Edit. The Edit Scenario tab appears with the 
scenario loaded. 

4. Edit the scenario:

• Remove windows

• Add windows

• Resize and reposition windows

• Security Access

5. When you are satisfied with your changes, click Scenario 
panel>Save or Save As.

6. Restart the scenario to see the changes.
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4.3.7 Start a Scenario

Start a Scenario in WallView

The Controller tab lists all available scenarios on the selected controllers. 

1. On the Controller tab, select a scenario in the Scenarios panel.

NOTE: To view scenario details, click Scenarios panel>Scenario 
Details. The scenarios for the selected controller are listed. Click a 
scenario to view the details. 

2. Click Start.

Scheduling a Scenario for Automatic Start

You can schedule a scenario to run once, or you can create a recurring 
schedule, for example hourly or weekly. WallManager checks for scheduled 
events at startup and at regular intervals while it runs.

1. On the Controller tab, select a scenario in the Scenarios panel. 

2. In the Scenarios panel click Schedule>Add.

3. To identify when the scenario can be run, specify a Start date and 
time and an End date and time. For example, you can specify that a 
scenario can be run from June 1, 1pm to June 30, 2pm.

4. Select the run frequency from the Recur options. The applications, 
media windows and device tasks will be run at the specified time 
interval, during the date and time periods specified. With the current 
example, if you select daily, the scenario will be run every day between 
the specified times.

• If you select the Weekly option, you will need to specify which 
days of the week apply.

• If you select the Monthly option, you will need to specify the dates 
that apply.

5. Click OK to add the schedule to the scenario.

To Edit/Delete a Schedule

1. On the Controller tab, select a scenario in the Scenarios panel. 

2. In the Scenarios panel click Schedule and select a schedule to edit or 
delete.

3. In the Scheduled Item dialog:

• Change schedule details and click OK to save, or

• Click Delete to remove the open schedule. 
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4.3.8 Arrange the Display Wall in Real Time

The Controller tab provides a real-time, live representation of the display 
wall. You can interact with the display wall by manipulating the windows in 
the controller view in the workspace. 

NOTE: If security is enabled, you must login with WallView and WallView 
Edit permissions in order to work with the display in real time.

Working with Wire Frames and Live View

The Controller tab allows you to manipulate the display wall windows with 
or without the content showing. If you have a large number of media 
windows on the display wall, you may find it easier and faster to work with 
Live View OFF.

1. On the Controller tab, select the controller you want to work with.

2. To turn Live View off, click Controller Views panel>Live View. 

Moving an Application

Click to select the application window and then use the left mouse button to 
drag to a new location. This re-location is temporary—upon re-launch, the 
application returns to the location specified in the scenario.

Resizing an Application

Click to select the application window and then use the left mouse button to 
drag the borders of the application. This resizing is temporary—upon re-
launch, the application returns to the size specified in the scenario. When 
resizing, certain applications will crop at some point.

Closing an Application

Click to select the application window and right-click to access the menu. 
Select Window>Close. 

4.3.9 Working in Interactive Mode

WallManager includes an interactive mode that allows you to work on a 
remote PC with applications that are running on the display wall. In this way 
you can accurately manipulate the display wall when you cannot see it.

1. On the Controller tab, right-click the wall display and click 
Interactive View. 

2. Use your mouse and keyboard to control the cursor and work with the 
controller desktop, and the application and media windows. 
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Mouse clicks on your desktop are mirrored on the display wall. Your 
interaction with the applications on your desktop is mirrored on the 
display wall as well.

NOTE: Interactive mode provides full access to MediaManager 
functionality. Use the right-click menu to access options. Because 
interactive mode works with the files and applications running on the 
controller, the changes you make will be saved with the channels and 
profiles you work with.

4.3.10 Stop a Scenario

If security is enabled, you must log in with Stop Scenario permissions in 
order to be able to stop scenarios.

Stop a Scenario Manually

The Scenarios gallery shows a list of available scenarios. Select the 
scenario you want to stop and click Stop. The applications that belong to the 
scenario are removed from the display wall.

Figure 4-36 Scenario Gallery

NOTE: You can stop any window on the display. Click the window and right-
click to access the Close option. 

Stop a Scenario Through Scheduling

Scenarios can be scheduled for a specific time span. When the time span 
expires, the scenario will automatically close.

Stop a Scenario with another Scenario

Scenarios can include Stop Scenario tasks. These tasks specify scenarios that 
will be shut down automatically before the new scenario is started.

4.3.11 Lockdown Mode

Lockdown mode shuts down the WallManager scheduler so that no new 
scenarios can be started on the display wall automatically. Scheduling will 
be enabled again when lockdown mode is turned OFF.
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If security has been enabled, users with a security level lower than Level 1 
will be unable to interact with the display wall until lockdown mode is 
turned OFF. If their session is closed during lockdown mode, these users will 
not be able to login again until lockdown mode is turned OFF. Only level 1 
users can log in during lockdown.

• To initiate lockdown mode, click the Lockdown Mode button at the 
top left of the Controller View window in the workspace. If security has 
been enabled, Lockdown mode can only be initiated by users with 
Lockdown mode permission.

• To exit Lockdown Mode, click the Lockdown Mode button at the top 
left of the Controller View window. If security is enabled, you must 
have security level equal to or higher than the user who initiated 
Lockdown mode. You must also have Lockdown permissions.

4.3.12 Shutting Down WallManager 

Close the WallManager application at any time. Shutting down the 
WallManager application does not shut down the display wall. Nor does it 
shut down scheduled scenarios or remote access. Scheduled scenarios and 
remote access are controlled by Christie Web Server (WallServer.exe) 
running on the controller, and continue to run until the service is stopped.

To shut down the WallManager application, access the WallManager button 
menu and click Exit WallManager.

4.4 About WallViewer

WallViewer is a browser-based application that lets you to view tiled 
multiple display wall remotely. 

WallViewer includes the following functionality:

• Launches and stops WallManager scenarios.

• Displays a representation of the display wall as a wireframe layoutor as 
a graphic representation of the displayed content using LiveView.

The WallViewer application is hosted by Christie Web Server which runs on 
the controller. You can access WallViewer from client NT/2000/XP 
workstations from a browser.

Security for WallViewer is managed in the WallManager software. See 
2.2.4 Security. 
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4.4.1 WallView Tab

WallViewer opens automatically in the WallView tab. WallView provides a 
real-time, live representation of the display wall. The panel on the left lists 
available scenarios with status indicators that turn green when a scenario is 
running. The panel on the right shows the applications and media currently 
on the display wall.

Figure 4-37 WallView Tab

You can select application windows and move, resize or close them. See 
4.3.8 Arrange the Display Wall in Real Time.

A right-click menu allows you to change the appearance of WallView. For 
example, you can turn LiveView ON or OFF, you can zoom the window, and 
you can display a grid and window labels.

Scenarios 

The panel on the left lists the scenarios available on the display wall. The 
right-click menu allows you to start and stop scenarios and to review their 
properties. You can double click a scenario to view the tasks that comprise it.
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Display Wall Workspace

The workspace displays a real-time representation of the information shown 
on the display wall. You can turn LiveView ON and see the contents of the 
windows as displayed on the wall. The right-click menu lets you position, 
resize, minimize, or close the windows on the display wall using the mouse. 

Edit Menu

Select All – Use this option to select all the windows.

Clear Selection – Use this option to deselect any selected windows.

View Menu

Zoom – Select from these options to help you focus on the part of the 
display wall you want to work with.

Zoom to fit – Select this option to fit the contents of the display wall 
into the WallView window. This setting make sure you can see the 
entire display wall.

Zoom to Actual – Select this option to zoom in to the display wall’s 
resolution. 

Zoom In – Select this option to narrow the focus on a specific part of 
the display wall.

Zoom Out – Select this option to view more of the wall display. 

Snap to Grid – Select this option to toggle an underlying grid to make 
aligning windows easier. 

Display Snap Grid – Select this option to show the underlying grid. 

Screen Co-ordinates – Select this option to toggle screen co-ordinate 
labeling.

Screen Boundaries – Select this option to toggle boundary display.

Window Menu

LiveView – Use this option to view the selected window with content. To 
view all windows with content, enable Live View in the Preferences section 
of the Administration tab.

Order – Use these options to position windows that overlap. 

To Front – Select this option to move the selected window on top of the 
other windows.

To Back – Select this option to move the selected window behind the 
other windows.
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Size – Use these options to quickly adjust the windows to a preset size. 

Maximize – Select this option to stretch the application across the 
entire display wall.

Minimize – Select this option to minimize the selected window to the 
Display Walls task bar.

Fit to Display – Select this option to fit the selected window to the 
screen. Select a window, right-click in the screen you want to fit the 
selected window to and click Window>Size>Fit to Display.

NOTE: Some application windows have properties that prevent them 
from being fit to the display. Such as, MediaManager windows with a 
locked aspect ratio, position, or size. Some applications like the 
Windows calculator do not resize.

Restore – Select this option to restore minimized and maximized 
windows. Right-click in the WallView window and click 
Size>Restore and select the window you want to restore.

Close – Select this option to close the application.

4.4.2 Set WallView Preferences

WallView is set up to open windows with LiveView disabled. You can 
change this behavior in the Preferences section of the Administration tab. 
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1. To enable LiveView for all windows, click the Administration tab. 
The Administration Status window appears.

Figure 4-38 WallView Preferences

2. In the Preferences panel, check the WallView Defaults>LiveView 
Enabled checkbox and click Update.

NOTE: The refresh rate for LiveView is set automatically to High. The 
speed depends on your CPU, memory, and the number of clients 
accessing the server. If you experience slow browser response, consider 
lowering the refresh rate.

3. Select the language to use in WallManager and check Remember 
Language to make the selection permanent.

4. You can change the TCP/IP port that WallView uses to communicate 
with the server. Only qualified system administrators should change the 
port number. New sessions start using the new port as soon as the 
Update button is clicked. Existing sessions continue using the old port.

NOTE: When security is enabled, you only see the WallView Port field if 
you have permissions to change it.

4.5 Browser Setup for WallViewer

Browser setup affects how WallViewer looks and functions.
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4.5.1 Internet Explorer

To check your Internet Explorer settings:

1. In Internet Explorer, click Tools>Internet Options. The Internet 
Properties dialog appears.

2. Click the Advanced tab.

3. In the Browsing section, make sure the Reuse windows for 
launching shortcuts option is unchecked. 

4. In the Java (Sun) section, make sure the Use JRE #.#.#_## for 
<applet> option is checked, where the version number is 1.6.0_16 or 
later.

Figure 4-39 Internet Explorer Advanced Settings

5. In the Multimedia section, make sure Show Pictures is checked.

6. Close the Internet Properties dialog.

4.5.2 Firefox

To check your Firefox settings:
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1. In Firefox click Tools>Options. The Options dialog appears. 

Figure 4-40 Firefox Options-Web Features

2. Click Web Features in the navigation panel at the left.

3. In the Web Features panel, if the Block Popup Windows option is 
checked, click the Allowed Sites button. The Allowed Sites dialog 
appears. 

Figure 4-41 Allowed Sites

4. Add the controller host name to the list of sites that can display pop-ups 
and click OK.

5. Make sure the Load Images, Enable Java, and Enable JavaScript 
options are checked in the Web Features panel.

6. Click Advanced in the navigation panel at the left.
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Figure 4-42 Firefox Options, Advanced Settings

7. In the Advanced tab, make sure the Open links from other 
application in option is set to a new window.

8. Click Ok to close the Options dialog.
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5 Remote Operation – 
Client PC
MASTERSuite includes the following client applications for remote 
operation of, and remote interaction with, the display wall.

• WallManager allows you to view and control the controller desktop 
from a remote PC. For installation, see 5.1 WallManager on a Remote 
PC. Interactive Mode in WallManager allows you to work remotely 
with applications running on the display wall. The applications display 
in WallManager on the client PC. Interactions with applications in 
WallManager are duplicated in real time on the wall display. For more 
information, see 4.3.9 Working in Interactive Mode.

• RemoteControl allows you to control the display wall using the mouse 
and keyboard at a remote PC. See 5.2 RemoteControl.

• RemoteDesktop allows you to set up a client PC as a source for 
MediaManager. You can control the display of the desktop through 
MediaManager. See 5.3 RemoteDesktop.

• WallLaunch allows you to start existing scenarios on the display wall 
without starting WallManager. WallLaunch can be run on the controller 
or on a remote PC desktop. See 5.4 WallLaunch.

• Christie RS-232 Control Server allows you to start and stop scenarios 
using a serial control device like Crestron or AMX. See 5.5 Christie RS-
232 Control Server.

• QuickLaunch allows you to start existing scenarios on the display wall 
without starting WallManager. QuickLaunch can be run on the 
controller or on a remote PC desktop. For more information, see 
QuickLaunch on page 2-34.

Client applications can be installed from WallManager (WallManager 
button>Client Applications) or from WallViewer (Administration tab>Client 
Applications). Once located, client application installs are identical.
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5.1 WallManager on a Remote PC

Recommended specification for remote installation

• 1.7GHz or faster processor

• 1GB or greater RAM

• 200MB available hard disk space (Dot Net Framework and 
WallManager)

To install WallManager

1. Start an internet browser.

2. Enter the name or IP address of the controller, for example 
http://controller, and press Enter.

Figure 5-1 WallViewer Initial Screen

NOTE: If WallViewer is not available, make sure that the Christie Web 
Server is running on the controller.

3. If WallManager security is enabled, log in with a valid user account.

4. Select the language you want to work in and click Select. WallViewer 
opens at the WallView tab.
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Figure 5-2 Display Wall

5. Click the Administration tab.

Figure 5-3 Client Applications Button

6. Click Client Applications in the left panel.
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Figure 5-4 Client Applications Panel

7. To install required supporting software, click Install WallManager 
Prerequisites.

NOTE: For first time installations, you may be prompted with an 
internet download dialog before the InstallShield Wizard appears. Make 
sure the Run option is selected and click OK. You may also be prompted 
with a security warning. Click Run to install the software.

8. Follow the directions in the installation wizard.

9. To install WallManager, click Install WallManager.

NOTE: For first time installations, you may be prompted with an 
internet download dialog before the InstallShield Wizard appears. Make 
sure the Run option is selected and click OK. You may also be prompted 
with a security warning. Click Run to install the software.

10. Follow the directions in the installation wizard.

11. Close the browser running WallViewer application.

NOTE: For information about installing and using the other client 
applications, refer to 5 Remote Operation – Client PC.

5.2 RemoteControl

MASTERSuite includes the ability to take control of the wall display cursor 
using a remote workstation’s mouse and keyboard. Depending on how 
RemoteControl has been configured, a user with a higher security level may 
be able to take control from a user with a lower security level. The system 
will notify you if someone else gains control.
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RemoteControl involves the following two components:

• 5.2.1 RemoteControl Server

• RemoteControl Server Setup on page 5-5

• RemoteControl Server Dialog on page 5-7

• RemoteControl Server Settings Dialog on page 5-7

• Troubleshooting RemoteControl Client on page 5-8

• 5.2.2 RemoteControl Client

• Taking Control on page 5-8

• Releasing Control  on page 5-10

5.2.1 RemoteControl Server

RemoteControl Server Setup

The controller comes installed with RemoteControl software. 
RemoteControl allows you to control the controller keyboard and mouse 
using IP protocol from a remote networked workstation. The remote 
workstation must be running Windows NT 4.0, Windows 2000, or Windows 
XP. If WallManager security is enabled, the user at the remote workstation 
must login with a valid WallManager username and password. 

RemoteControl runs as a service on the controller and displays an icon in the 
controller’s system tray. 

Figure 5-5 System Tray 

1. On the controller, double-click the RemoteControl Server icon in the 
system tray. The RemoteControl Server dialog appears.

Figure 5-6 RemoteControl Server
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2. Click Settings. The Settings dialog appears with the Configuration 
tab displayed. 

Figure 5-7 Configuration

3. Accept the default values for Port and Timeout. If you need to change 
the values, contact your system administrator for appropriate settings.

4. Select the language option and Save.

5. To restrict access to the display wall to a list of specific IP addresses, 
click the Access Control tab. The Access Control dialog appears.

Figure 5-8 Authentication

6. Check the Restrict Access to hosts in the list above option.

7. Click Add, enter the IP address of the computer that can access the 
display wall, and click OK. 

8. Repeat for each IP address you want to be able to access.

9. Click Save to save the setup information.

NOTE: You can also use WallManager’s security to restrict users by name. 
Make sure WallManager security is enabled. Enable RemoteControl 
permission only for those users who should have access to this function. 
Only users with valid WallManager accounts and with RemoteControl 
permission will be able to use RemoteControl. 
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RemoteControl Server Dialog

The RemoteControl Server dialog provides status information about the 
RemoteControl function.

Status Log – Shows the status of RemoteControl.

Settings – Opens the Settings dialog and allows you to specify connection 
information and to control access to specified IP addresses.

Clear Log – Select this option to clear the Status Log.

Exit – Select this option to exit the RemoteControl dialog.

Clients Connected – This field identifies the number of computers that 
have an open RemoteControl connection.

Client in Control – This field identifies the WallManager user who is 
currently in control of the display wall cursor.

RemoteControl Server Settings Dialog

Use the Settings dialog to change connection parameters and to limit access 
to specific IP addresses.

Port – Identifies the port that the server listens to for requests from the 
RemoteControl client. Use the default value. If you need to change the port 
number, contact your network administrator.

Timeout – Identifies the length of time that a connection can be idle before 
it is disconnected. Use the default value. If you need to change this value, 
contact your network administrator.

IP Address/Host – This list identifies the computers that can access the 
display wall through the RemoteControl function.

Add – Use this button to add an IP address or host name.

Delete – Use this button to delete the selected IP address or host name from 
the list.

Restrict Access to Hosts in the List Above – Enable this option to 
restrict access to RemoteControl functionality to the list shown. No other 
computers will be allowed access.

Save – Use this button to save the RemoteControl settings.
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Troubleshooting RemoteControl Client

Message: “Failed to connect to server”  – Possible Solution:

• Make sure RemoteControl service is running on the controller.

• Check that the Host Address specified on the RemoteControl Client 
window correctly points to your controller. 

Message: “A required privilege is not held by the client” – 

Possible Solution:

• Make sure RemoteControl service is running on the controller with 
Administrative permissions with “act as part of the operating system” 
enabled.

• Consult your RS-232 controller documentation for further details. 

5.2.2 RemoteControl Client

Taking Control

1. In WallManager, click the WallManager button and select Install 
Client Applications. 

Figure 5-9 Client Applications

2. Click Connect RemoteControl. 

3. Close the Client Applications window.
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Figure 5-10 Remote Control Client 

NOTE: For first time installations, you may be prompted with an 
internet download dialog before the InstallShield Wizard appears. Make 
sure the Run option is selected and click OK. You may also be prompted 
with a security warning. Click Run to install the software.

4. To identify the controller, click Settings. 

Figure 5-11 Settings 

5. Enter the controller host name or IP address in the Host field.

6. Select the language you want RemoteControl to work with and click 
Save.

7. On the RemoteControl Client dialog (Figure 5-10), click Connect.

8. If security is enabled, log in with valid user and password.

When you are connected to the controller, the RemoteControl Client 
window shows the status of the connection in the lower left panel and 
the Disconnect button is enabled.

Figure 5-12 Connection Status

9. Press SHIFT+ESC to take control.
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Releasing Control

1. To release control of the controller press SHIFT+ESC again.

5.3 RemoteDesktop

RemoteDesktop lets you display and interact with Windows and Linux 
desktops by setting up the client PCs as sources for MediaManager 
windows. The controller comes installed with the server portion of 
RemoteDesktop. The remote workstation needs to be set up to allow 
MediaManager to connect. 

• RDClient

• Set up a Linux Desktop for Display 

5.3.1 RDClient

• Installing RDClient

• Starting RDClient

• Configuring RDClient

• Closing RDClient

Installing RDClient

1. In WallManager, click the WallManager button and select Install 
Client Applications. 

Figure 5-13 Client Applications 

2. Click Install Remote Desktop Client to start the installation wizard.
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Figure 5-14 RDClient Installation Wizard

NOTE: For first time installations, you may be prompted with an 
internet download dialog before the InstallShield Wizard appears. Make 
sure the Run option is selected and click OK. You may also be prompted 
with a security warning. Click Run to install the software.

3. Click Next and type the user information.

Figure 5-15 User Information

4. Click Next and specify where the program files are stored.

Figure 5-16 Destination Folder
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5. Click Next and Next again to confirm the installation.

6. When the installation is complete, click Finish to dismiss the wizard.

7. Close the Client Applications window.

Starting RDClient

Start RDClient by double-clicking on the icon located on the desktop or by 
navigating through the Start Menu: Start> Programs> Christie> 
MASTERSuite> RDClient. 

When RDClient is running, its icon is visible in the system tray. 

When a user is connected to RDClient, the RDClient icon background 
changes from black to white to show that there is an active connection. 

Closing RDClient

To close the RDClient application, right-click on the RDClient tray icon 
and select Close RDClient from the menu.

Configuring RDClient

1. To open RDClient Properties double-click the RDClient icon in the 
system tray. 

2. On the Authentication tab, make sure the VNC Password 
Authentication option is selected and click the Configure button.

Figure 5-17 RDClient Properties - Authentication Tab
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NOTE: If you want MediaManager to connect to RDClient without 
password security, contact your system administrator to determine if 
you are operating in a secure environment, such as a secure LAN or 
firewall-protected network. If you are not working in a secure 
environment, the No Authentication option is not recommended.

3. On the VNC Server Password dialog, specify and confirm the 
password that MediaManager will use to connect to RDClient. The 
password can be up to 8 alphanumeric characters. Click OK to close the 
dialog.

Figure 5-18 Password Authentication

4. Click OK to close the dialog.

5. On the Connections tab, make sure the option Accept connections 
on port: is checked and specify the port MediaManager will use to 
connect to RDClient.

6. On the Desktop tab, specify the background information that will be 
sent to the display wall. 

Unless the information is required, performance can be improved by 
selecting all options. Not sending the wallpaper and interface effects 
decreases processor usage and network bandwidth.

• Remove desktop wallpaper turns OFF the wallpaper on the 
client PC and also disables Active Desktop components.

• Disable user interface effects disables desktop enhancements; 
such as font smoothing, window title bar shading, menu animation 
and so on.

NOTE: Update performance depends on the general performance of the 
remote workstation, the graphics drawing activity of the information 
being sent to the display wall, network performance, and the frame rate 
setting specified in the MediaManager channel setup. If the workstation 
is running very sluggishly while there is an active RDClient connection, 
it is possible to improve the workstation performance by decreasing the 
RemoteDesktop frame rate in MediaManager. 
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7. On the Capture Method tab, you can specify how the information 
sent to the display will be updated.

Figure 5-19 RD Client Properties - Capture Method

• Poll for changes to the desktop - choose this option when 
the client PC is running video. VNC server polls strips of the screen 
for changes. The polling mechanism attempts to minimize the load 
on the server computer while delivering a reasonable level of 
responsiveness. The upgrading may visibly degrade if you have a 
slow connection.

• Use VNC hooks to track changes - choose this option 
unless you want to send video from the client PC to the display 
wall. This update mechanism is more efficient than continuous 
polling, but relies on certain properties of Windows applications 
and so can "miss" updates in some situations. It polls the screen 
infrequently to catch any missed updates. 
VNC Hooks cannot track console windows because of limitations 
in the operating system. Check Poll console windows for 
updates, to poll console windows for changes, then VNC Server 
will track the visible parts of console windows. 

• Capture alpha-blended windows - choose this option when 
you need to display an application with tool tips. This option 
increases the load on the server and may cause the cursor to flicker.

8. On the Languages tab, select the language MediaManager will use to 
display the RDClient Properties dialog.

9. Click OK to confirm your changes and close the dialog. Changes take 
effect as soon as you click OK.

Note the IP address, the port number, and password. You will need this 
information to set up a Remote Desktop channel in MediaManager, see 
Create New Channel on page 2-5.
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5.3.2 Set up a Linux Desktop for Display 

To mirror the desktop of a Linux machine, you will need a program like 
KDE Desktop Sharing or x11vnc. These programs allow you to view and 
interact with the Linux desktop using the RD Client on the display wall. The 
KDE Desktop Sharing program is installed with the KDE Network package 
on KDE Linux systems. x11vnc and similar VNC programs are available 
free for download on the internet. Follow the installation and setup 
instructions for your VNC program.

• Ensure that your VNC program allows the connection, for example in 
the KDE Desktop Sharing application, check Allow uninvited 
connections. x11VNC allows connections by default.

• Ensure that your firewall does not block the connection.

• Note the Linux system IP address, and the port number and password 
used by the Linux VNC program. You will need this information to set 
up a Remote Desktop channel in MediaManager, see Create New 
Channel on page 2-5.

5.4 WallLaunch

WallLaunch allows you to start scenarios from a remote PC without opening 
WallManager. By passing parameters to the WallLaunch program, users are 
able to create multiple desktop shortcuts for launching frequently used 
scenarios. Direct calls to WallLaunch can be incorporated into end-user 
software to allow for specified tasks and events to be launched for example 
when alarm conditions are encountered.

Install WallLaunch

1. In WallManager, click the WallManager button and select Install 
Client Applications. 

Figure 5-20 Client Applications 
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2. Click Install WallLaunch to start the installation wizard.

Figure 5-21 WallLaunch Installation Wizard

NOTE: For first time installations, you may be prompted with an 
internet download dialog before the InstallShield Wizard appears. Make 
sure the Run option is selected and click OK. You may also be prompted 
with a security warning. Click Run to install the software.

3. Click Next and type the user information.

4. Click Next and the Server Name window appears.

Figure 5-22 Server Name

5. Identify the controller, and click Next. The Custom Setup window 
appears.
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Figure 5-23 Custom Setup

6. Click Next and the Ready to Install the Program window appears.

Figure 5-24 Ready to Install the Program

7. Click Install. The wizard displays progress information and then the 
InstallShield Wizard Completed window.

[

Figure 5-25 Installation Complete Notification

8. Click Finish to dismiss the wizard.

9. Close the Client Applications window.
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Select Language for WallLaunch

You can specify the language to use in WallLaunch.

1. Start WallLaunch by navigating through the Start Menu – 
Start>Programs>Christie>MASTERSuite>WallLaunch. The 
WallLaunch window appears.

 

Figure 5-26 WallLaunch

2. Click the Settings button. The Settings dialog appears.

Figure 5-27 WallLaunch Settings

3. Select the language you want to use with WallLaunch, and click Save.

Start a Scenario Using WallLaunch

WallLaunch automatically lists all the scenarios that are available when you 
start WallLaunch. If WallManager security is enabled, you will only see the 
scenarios available for your security level.

1. Start WallLaunch by navigating through the Start Menu – 
Start>Programs>Christie>MASTERSuite>WallLaunch. The 
WallLaunch window appears.

Figure 5-28 WallLaunch

2. Select a scenario and click Start. The scenario is started on the display 
wall.
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Create a Scenario Shortcut

WallLaunch allows you to create shortcuts for scenarios, for example on a 
remote desktop.

1. Start WallLaunch by navigating through the Start Menu – 
Start>Programs>Christie>MASTERSuite>WallLaunch. The 
WallLaunch window appears. 

2. Select a scenario and click Create Shortcut. A dialog window opens, 
prompting you to select where to create the shortcut. 

Edit a WallLaunch Shortcut

WallLaunch allows you to create shortcuts to start a scenario. You can edit 
such a shortcut to change what the shortcut does.

1. Right-click on the shortcut and click Properties.

2. In the Target field, move the cursor to the end of the command. You 
should see the following: -hhostname “-lscenario”
where hostname identifies the system that the scenario will be run on. 

3. You can make the following changes:

• To change the shortcut to stop a scenario, change the –l to a –k in 
the –l scenario parameter.

• To specify a different host change the hostname in the 
–hhostname parameter.

5.5 Christie RS-232 Control Server

The RS-232 Control Server allows you to start and stop scenarios on the 
display wall using a serial device (e.g. Crestron or AMX). The controller 
comes installed with the RS-232 Control Server and the service runs 
automatically when the controller is turned ON.
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1. On the controller, open the RS-232 Control Server window by double-
clicking on the RS-232 icon in the system tray. The Christie RS-232 
Control Server dialog appears.

Figure 5-29 RS232 Control Server

2. Click the Settings button. The Settings dialog appears.

Figure 5-30 Settings

3. Adjust the communication settings to match your device and click OK 
to save the settings and dismiss the Settings dialog.

4. Click New to setup the controller. The Serial Event Properties dialog 
appears.

Figure 5-31 Serial Event Properties

5. Record the serial data associated with a button or action on the serial 
control device by clicking the Record button. The RS-232 controller 
listens and records the next action at the serial control device. 
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NOTE: You can specify the serial data string associated with a button or 
action on the serial control device by hand. For more information see 
the documentation that came with your serial control device.

6. Select an action to be associated with the serial data string.

• Start the scenario specified in the Scenario Name field. 

• Stop the scenario specified in the Scenario Name field.

• Switch the video source. All video sources playing the Current 
Channel Name are switched to play the New Channel Name 
independent of scenario settings.

7. Click Save to save the data and close the dialog.
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6 Setting Wall Display 
Properties
MediaManager supports two graphics cards, the D4A module and the 
original D4 module. For technical information about the two graphics cards, 
see the Specifications section of the TVC Hardware Manual.

6.1 Configuring Display Properties

Additional display properties for the D4A and D4 modules allow you to 
customize the way you view your display wall. You can specify parameters 
such as number and configuration of screens, color depth and refresh rate. 

Important! Close all MediaManager windows (RGB and/or Video) before 
changing the display properties. If these settings are modified while 
MediaManager windows are open, the system will exhibit artifacts or 
unpredictable behavior until the system is re-booted.

6.1.1 Change display Settings

To access the additional display properties, do the following:

1. Right-click on the desktop and select Properties.

2. Click on the Settings tab.

3. Click the Advanced button.

4. On the Advanced Settings dialog, click the Christie tab.

The Screen Configuration represents the number of screens and 
configuration of the currently defined display wall. This will change 
automatically as the settings in the rest of the window are modified.
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Figure 6-1 Display Properties

5. Update the settings as required. For information about the settings, see 
Screen Configuration Options on page 6-2.

6. Click OK to accept the changes and close the dialog.

Screen Configuration Options

Resolution per Screen  – Enter a resolution that each adapter will output 
by adjusting the slide bar. This should be set to the resolution expected by 
the display devices. See the following table for available display modes. If 
the Compatible Modes Only checkbox is enabled, then the available 
resolutions will be restricted to modes that are compatible with the display 
device.

Refresh Rate – Use the Refresh Rate drop-down menu to select a refresh 
frequency for the system. The refresh rates available depend on the 
resolution selected. They correspond to the VESA standards.

Color Palette – Use the Color Palette drop-down menu to select a color 
depth setting used by the system. Select from 8bpp, 16bpp (recommended 
setting) or 32 bpp.

No. of Screens – Enter the number of screens in your display wall by 
entering a value in the No. of Screens field. You can increase or decrease the 
value in this field using the up or down arrows. The value you enter in this 
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field depends on the number of D4A/D4 modules installed in your controller. 
Important! Each D4A/D4 module can be connected to a maximum of four 
display devices. The maximum number of D4A modules that can be 
installed in a controller is 16, making a total of 64 screens that can be 
handled. The maximum number of D4 modules that can be installed in a 
controller is 10, making a total of 40 screens that can be handled. It is 
important you do not exceed the hardware limitations of your system. If the 
value is set beyond the capabilities of your hardware, the system will display 
as a 1 x 1 (1600 x 1200 @ 60Hz).

NOTE: If you increase the number of screens (beyond what is configured at 
the time the system is booted), you will be required to reboot the system 
before the changes take place. This is due to the operating system initializing 
only the used adapters.

Screen Arrangement – Select this drop-down menu to choose a display 
wall configuration. All valid display wall configurations are listed. 

Source of Mode – The display driver reads the Extended Display 
Information Data (EDID) from each monitor and reads the Registry to find 
detailed display timing information. The Source of Mode group box shows 
which mode sources are available for the selected resolution and color depth. 
Source of Mode has 4 options. 

• Default - Monitor timing information from the display driver's internal 
tables. 

• Custom - Monitor timing information from the Registry. For more 
information, see 6.1.2 Defining Custom Modes.

• Monitor (Master) - Monitor timing information from the monitor 
attached to output 1 of the D4/D4A outputs. 

• Monitor (Each) - The monitor timing information from each monitor 
is used for the output connected to that monitor.

Force DVI Output – When the display driver initializes it reads the 
EDIDs of the attached screens to determine if the DVI (digital) or analog 
outputs should be used. If the display device does not provide EDID 
information then this control is used to decide which output to enable. 

If the check box is in an indeterminate state it signifies the enabled outputs 
are not as requested by the user. This will occur if a mixture of analog and 
digital screens are used or if the type of display device used is different to the 
Force DVI state.

Since the DVI (digital) output supports a lower pixel dot-clock frequency 
than the analog output, the resolution dialog is updated when the check box 
is changed to reflect the resolutions supported by the active output.
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Compatible Mode Only – If EDID information is available for the 
display device(s), then checking this box restricts the list of available 
resolutions to those that are compatible with the monitor(s). If EDID 
information is not available, then this control has no effect.

6.1.2 Defining Custom Modes 

The D4A module allows you to define Custom Modes in the Registry for 
each device. Registry entries for multiple devices are numbered Device0, 
Device1, etc. 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\DGC
123\Device0

For the D4 module use: 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Hor
izon\Device

In a REG_MULTI_SZ value named "Mode". Each mode definition is on a 
single line (there can be multiple mode definitions each on a new line). The 
mode definition should be typed in the following format as a comma-
separated string: 

X, Y, Refresh, hfp, hsync, hbp, vfp, vsync, vbp, hpol, vpol, dotclock

For example: 1280,1024,50,24,240,144,3,3,1,0,0,90139 

The following table explains what each value represents: 

NOTE: If this registry value is amended the Christie tab must be closed then 
re-opened to make sure the new values are read from the Registry. 

Parameter Details 
X Active display width in pixels 
Y Active display height in lines 
Refresh Refresh rate displayed in dialog. Also used for calculating dot-

clock
if no dot-clock value is provided 

hfp Horizontal front porch in pixels (value must be divisible by 8) 
hsync Horizontal sync width in pixels (value must be divisible by 8) 
hbp Horizontal back porch in pixels (value must be divisible by 8) 
vfp Vertical front porch in lines 
vsync Vertical sync width in lines 
vbp Vertical back porch in lines 
hpol Horizontal sync polarity (0 = negative, 1 = positive) 
vpol Vertical sync polarity (0 = negative, 1 = positive) 
dotclock Pixel dot-clock in KHz (optional). Allows more accurate 

control of the dot-clock 
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7 Troubleshooting

7.1 Live View/Interactive Mode

Interactive Mode doesn't match how my wall appears.

• Check the Controller tab and ensure that you are connected to the 
correct wall. Deselect all controllers, close all WallView windows and 
then re-connect to the wall.

• Your computer may have stopped communicating with the wall or is not 
receiving the updates correctly. Close WallManager and re-open it to re-
establish the connection.

Some of my key presses don't do anything in Interactive Mode. 

Some keys and key combinations are not captured by Interactive Mode. This 
allows you to maintain control of both your system and the TVC 
controller(s) at the same time. If you would like to control the controller 
only, use RemoteControl, see 5.2RemoteControl. RemoteControl lets you 
use your mouse and keyboard for one TVC controller at a time. You must be 
able to see the display wall to use RemoteControl as WallManager does not 
track the position of the cursor on the display wall.

7.2 Launch Display Control

The Launch Display Control button is greyed out or does 
nothing.

Launch Display Control accesses the Christie PowerTool application. If the 
PowerTool application is not installed on your system:

1. Click the WallManager button at the top-left of the WallManager 
window.

2. Choose Install Client Applications. 

3. Click PowerTool to install the application on your system.
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7.3 Security/Permissions

Some areas of the application are not displayed and/or I cannot 
set permissions for.

• If changes have been made which would affect Security/Permissions 
options, the TVC controller may require a restart before the new or 
updated options display under Security Settings and Permissions.

• Security Settings or Permissions are not available for that area of the 
application. Please contact our support team at 
support@christiedigital.com for further assistance. 

7.4 WallManager

7.4.1 Scenarios

Whenever I try to start MediaManager I get a message saying 
"Could not start scenario.", what does this mean?

• MediaManager requires the following Services to be running. 

a. On the TVC controller access Start>Control 
Panel>Administrative Tools>Services. 

b. In the services window, scroll down the list to the Christie 
entries. All Christie services should have a status of “Started”.

c. For Christie services that are not running, right-click the service 
and choose "Start".

• MediaServer is a background application that should be running in order 
to launch MediaManager windows. Check your Task Manager to ensure 
this program is running. If MediaServer is not running:

a. Browse to the Jetty folder in the MASTERSuite directory 
structure. The default location is: c:\Program files\Christie 
Digital Systems\MASTERSuite\Christie\Jetty.

b. In the Jetty folder, double click MediaServer.exe to start the 
application. 

• Rebooting the TVC controller will generally resolve any issues relating 
to required applications not running.
7-2 MASTERSuite 5.0 User Manual
020-100448-01 Rev. 1 (03-2010)



Section 7: Troubleshooting
7.4.2 Wall Magnification

After I launch Wall Magnification on my wall, I cannot turn it off.

With the appropriate server selected in WallView, right-click the 
WallMagnification application and choose the Close option. 
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